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IMPORTANT SAFETY AND
INSTALLATION INSTRUCTION
SAVE THESE INSTRUCTIONS

INSTRUCTIONS PERTAINING TO RISK OF FIRE, ELECTRIC
SHOCK, OR INJURY TO PERSONS

WARNING — when using electric products, basic precautions should be followed, including the
following:

1. Read all of the safety and installations instructions and explanation of graphic symbols
before using the product.

2. The product must be grounded otherwise it could malfunction or breakdown. Grounding
provides a path of least resistance or electric current to reduce the risk of electric shock. This
product is equipped with a power supply cord having an equipment-grounding conductor and
a grounding plug. The plug must be plugged into an appropriate outlet which is properly
installed and grounded in accordance with all local codes and ordinances.

DANGER - Improper connection of the equipment-grounding can result in a risk of electric
shock. Do not modify the plug provided with the product — if it will not fit the outlet have a
proper outlet installed by a qualified electrician. Do not use an adapter that defeats the
function of the equipment-grounding conductor. If you are in doubt as to whether the product
is properly grounded, check with a qualified serviceman or electrician.

3. Do not use this product near water — for example, near a bathtub, washbowl, kitchen sink,
in a wet basement, or near a swimming pool, or the like.

4. This product should only be used with a stand or cart that is recommended by the
manufacture.

5. This product, either alone or in combination with an amplifier and speakers or headphones,
may be capable of producing sound levels that could cause permanent hearing loss. Do not
operate at a high volume level or at a level that is uncomfortable. If you experience any
hearing loss or ringing in the ears, you should consult an audiologist.

6. The product should be located so that its location or position does not interfere with its
proper ventilation.

7. The product should be located away from heat sources such as radiators, heat registers, or
other products that produce heat.

8. The product should be connected to a power supply only of the type described in the
operating instructions or as marked on the product.

9. The power-supply cord of the product should be unplugged from the outlet when left
unused for a long period of time. When unplugging the power supply, do not pull on the cord,
but grasp it by the plug.

10. Care should be taken so that objects do not fall and liquids are not spilled into the
enclosure through openings.
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11. The product should be serviced by qualified service personnel when: A. The power supply
cord or plug has been damaged. Objects have fallen, or liquid has spilled into the product, or
C. The product has been exposed to rain, or D. The product does not appear to be operating
normally or exhibits a marked change in performance, or E. The product has been dropped, or
the enclosure damaged.

12. Do not attempt to service the product beyond that described in the user maintenance
instructions. All other servicing should be referred to qualified service personnel.

13. WARNING - Do not place objects on the power supply cord, or place the product in a
position where anyone could trip over, walk on, or roll anything over cords of any type. Do not
allow the product to rest on or be installed over cords of any type. Improper installations of this
type create the possibility of a fire hazard and/or personal injury.

The lightning flash with arrowhead symbol, within an equilateral triangle, is

intended to alert the user to the presence of uninsulated "dangerous voltage"
within the product’s enclosure that may be of sufficient magnitude to constitute a risk
of electric shock to persons.

The exclamation point within an equilateral triangle is intended to alert the user
to the presence of important operating and maintenance (servicing) instructions
in the literature accompanying the product.

No part of this documentation may be reproduced in any form whatsoever or be stored in any
data retrieval system without prior written permission of the copyright owners.

This documentation is supplied on an as-is basis. Information contained within this
documentation is subject to change at any time without notice and must not be relied upon.
All company and product names are ™ or Registered Trademarks ® of their respective
owners. Windows 7 and Windows 10 are a trademark of Microsoft Corporation.

Merging Technologies makes no warranties express or implied regarding the Hapi embedded
software, its quality, performance, merchantability or fitness for a particular purpose. The
software is supplied “as is” you, the purchaser, are assuming the entire risk of the results of
using this Merging Technologies software.

In no circumstances will Merging Technologies, its owners, directors, officers, employees or
agents be liable to you for any consequential, incidental or indirect loss or damages including
loss of time, loss of business, loss of profits, loss of data or similar resulting from the use of or
inability to use the Merging Technologies hardware and or software or for any defect in the
hardware software or documentation.

© Copyright Merging Technologies Inc. 2022. All rights reserved.
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IMPORTANT NOTICE:

Please read the following information very carefully before attempting any installation. Failure to comply
with the precise instructions may result in damage to your Merging hardware. Please read this entire
section of the manual carefully before installation.

STATIC DANGER NOTICE:

Please note that the Hapi contains delicate electronic components that can be damaged or even
destroyed when exposed to static electricity. Take all necessary precautions not to discharge static
electricity when touching any of the Hapi connectors.

Product Regulatory Compliance
The Merging Hapi Network Converter is designed and tested to meet the standards and regulations
listed in the following sections.

Product Safety Compliance

Hapi complies with the following safety requirements:

e UL 1950 — CSA 950 (US/Canada).

EN 60 950 (European Union).

IEC 60 950 (International).

CE — Low Voltage Directive (73/23/EEC) (European Limits).
EMKO-TSE (74-SEC) 207/94 (Nordics).

Product EMC Compliance

The system has been tested and verified to comply with the following EMC regulations:

e FCC (Class A Verification) — Radiated and Conducted Emissions (USA).

CISPR 22, 3rd Edition (Class A) — Radiated and Conducted Emissions (International).
EN45022 (Class A) — Radiated and Conducted Emissions (European Union).
EN45024 (Immunity) (European Union).

EN6100-3-2 & -3 (Power Harmonics and Fluctuation and Flicker).

CE - EMC Directive (89/33/EEC) (European Union).

Electromagnetic Compatibility Notices

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two

conditions: (1) this device may not cause harmful interference and (2), this device must accept any

interference received, including interference that may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class A digital device,

pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection

against harmful interference in a residential installation. This equipment generates, uses, and can

radiate radio frequency energy and, if not installed and used in accordance with the instructions, may

cause harmful interference to radio communications. However, there is no guarantee that interference

will not occur in a particular installation. If this equipment does cause harmful interference to radio or

television reception, which can be determined by turning the equipment off and on, the user is

encouraged to try to correct the interference by one or more of the following measures:

e Reorient or relocate the receiving antenna.

e Increase the separation between the equipment and the receiver.

e Connect the equipment to an outlet on a circuit other than the one to which the receiver is
connected.

e Consult the dealer or an experienced radio/TV technician for help.

Any changes or modifications not expressly approved by the grantee of this device could void the user’s

authority to operate the equipment. The customer is responsible for ensuring compliance of the

modified product.

Only peripherals (computer input/output devices, Ethernet switches, terminals, printers, etc.) that

comply with FCC Class B limits may be attached to this computer product. Operation with noncompliant

peripherals is likely to result in interference to radio and TV reception.

All cables used to connect to peripherals must be shielded and grounded. Operation with cables,

connected to peripherals that are not shielded and grounded, may result in interference to radio and TV

reception.
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Environmental Limits

System Office Environment Parameter Limits

Operating Temperature +5 degrees C to +55 degrees C with the maximum rate of change not to
exceed 10 degrees C per hour.

Non-Operating Temperature -40 degrees C to +70 degrees C

Non-Operating Humidity 95%, non-condensing @ 30 degrees C

Operating Shock No errors with a half sine wave shock of 2G (with 11-millisecond duration).
Package Shock Operational after a free fall, 60 cm depending on the weight.

ESD 15kV per Merging Environmental Test Specification
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EU Declaration of Conformity (DoC)

Merging Technologies S.A.
Le Verney 4

CH-1070 Puidoux
Switzerland

declares that the DoC is issued under its sole responsibility that the product:

Model: Hapi MkiI
Type: IOC-HAPI-MKII

with the included component:
Power supply: PSSBU31-105

and all variations specified in the annex are in conformity with the provisions of the following
EU directive(s) (including all applicable amendments); and are designed and manufactured
with application of the harmonized standards.

The history of this document is listed on the last page.

Puidoux, March 22, 2021 Claude Cellier, CEO
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Applied directives and standards:

The devices: IOC-HAPI-MKII comply with the following:

Pos.-No. Document Short description Issued / Version

Low Voltage Directive
2014/35/EU

Electrical Safety
(publication references
OJEU L 96, 29.03.2014,
p.357-374)

3010 2014/35/EU 2014-02

Audio/video, information
and communication
3301 EN 62368-1 technology equipment -
Part 1: Safety
requirements

2014 + AC:2015
+Al11:2017

EU-Regulation for External
Power Supplies (Energy

7551 No. 2019/1782 Efficiency) (publication 2020-04
references OJEU L 272,
25.10.2019, p. 95-106)

RoHS Directive

2011/65/EU

Restriction of the use of

certain hazardous .
2011- h all

7801 2011/65/EU substance 011-06 with a

(publication references OJ L

174, 01.07.2011, p.88-110)

amended

by (EU) 2015/863)

amendments

Technical documentation
for the assessment of
electrical and electronic
7820 EN IEC 63000 products with respect to 2018-12
the

restriction of hazardous
substances

Document History

Revision Date: Revision Description Remarks

2020-03-22 First version
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Hapi Warranty Information

This product is warranted to be free of defects in materials and workmanship for a period of two years
from the date of purchase. Merging Technologies, Inc. extends this Limited Warranty to the original
purchaser.

In the event of a defect or failure to confirm to this Limited warranty, Merging Technologies, Inc. will
repair or replace the product without charge within sixty (60) days. In order to make a claim under this
limited warranty, the purchaser must notify Merging Technologies, Inc. or their representative in writing,
of the product failure. In this limited warranty the customer must upon Merging Technologies, Inc.
request, return the product to the place of purchase, or other local designation, for the necessary
repairs to be performed. If the consumer is not satisfied with the repair, Merging Technologies, Inc. will
have the option to either attempt a further repair, or refund the purchase price.

This warranty does not cover: (1) Products which have been subject to misuse, abuse, accident,
physical damage, neglect, exposure to fire, water or excessive changes in the climate or temperature,
or operation outside maximum rating. (2) Products on which warranty stickers or product serial numbers
have been removed, altered or rendered illegible. (3) The cost of installations, removal or reinstallation.
(4) Damages caused to any other products. (5) Do not attempt to service the equipment. There are no
user serviceable parts inside*. Please refer all servicing to an authorized Merging sales partner. Any
attempt to service the equipment will expose you to a risk of electric shock, and will void the
manufacturer’s warranty.

* Replacing or adding a AD, DA or MADI module and adjusting the DA module dip switch of legacy DA (output) is
permitted under the supervision of a Merging sales partner. Any other modification will void the Hapi warranty.

Contacting Merging Technologies
International Office:

Merging Technologies S.A.

Le Verney 4

CH-1070 Puidoux

Switzerland

Phone: +41 21 946 0444
Fax:  +41 21 946 0445

USA:

Merging USA (Independent Audio)
43 Deerfield Road

Portland,

ME 04101-1805

United States of America

Phone: +1 (207) 773 2424
Fax:  +1(207) 773 2422

For all documentation inquiries or suggestions for improvement:
www.merging.com

© 2021 All rights reserved. Merging Technologies, Horus and Hapi are registered Trademarks of
Merging technologies SA.

Product features and specifications are subject to change without notice.

Merging Technologies SA shall not be liable for technical or editorial errors contained herein, nor for
incidental or consequential damages resulting from the furnishing, performance or use of this manual.
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Introduction to HAPI MKII

Modular by Design

Hapi, the son of Horus. Born from the most flexible and sonically transparent audio interface and
providing the same RAVENNA / AES67 connectivity as its father, Hapi is both the perfect primary
interface for smaller systems as well as the ultimate accessory for a system using Horus where control
room I/O is required. Hapi was designed to give its users an Audio I/O channels flexibility while offering
an unprecedented level of quality in such a small form factor.

Providing as standard; 8 channels of AES- EBU I/O plus 8 ADAT or 2 SPDIF 1/O (on TOSLINK) and 2
Network interfaces 2 slots for ADS8D/AD8P, DA8/DA8P, MADI or PT64 option cards. Once the Hapi is
fully loaded with option cards, it is capable of achieving 88 inputs and 90 outputs @ 1FS There are
indeed 2 more output channels than input channels, including the Stereo Headphone Monitoring.

Route Signal Anywhere

Hapi has been designed so that any input can be routed to any number of outputs as required
simultaneously. With comprehensive routing pages accessible both locally on the touchscreen and by
remote access using a standard web browser, Hapi is the answer to signal flow management in your
studio.

Green Built

For environmentally-conscious users, Hapi has been designed meticulously in order to keep power
consumption at an incredible minimum. A fully loaded Hapi running all channels of phantom power will
only draw about 30W, making it more affordable to run than your kitchen lights.

HAPI MKII Key Features

* Up to 88 inputs and 90 outputs @1FS

* 8x AES/EBU + 8x ADAT or 2x SPDIF (Optical)

» Standard modules support 44.1kHz to 192kHz and Premium up to DXD/DSD256.
+ Signal routing from any input to any combination of outputs

* RAVENNA/AESG67 Compatible (Hapi MKII supports Network redundancy and Network Switch mode)
* Browser-based remote access using any web enabled device

* AC or DC power supply options

* Modular design for additional analog and Digital /O

* Near-zero latency from in to out (<1ms)

* Main rotary control button

* ST2022-7 Support (Seamless Protection Switching)

* Network Switch mode support (allowing daisy chain for an extra network device)
+ Additional Roll Off filters

* Per channel DA Trims level and polarity support

* Per channel Headphones Trims level and polarity support

» Routing support with per channel support

» Mastering grade Headphone Amp

» Powerful Headphone Amp suitable for ultra-low to very high impedance headphones.
* Headphones DSD volume support (DSD64, DSD128, DSD256)

» Headphones DSD256 support

» OLED display for local control access
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RAVENNA

The Hapi has been designed so that the MADI, AES, SPDIF/ADAT, PT64 and Analog modules can all
feed into or take their sources from the network over RAVENNA streams, providing up to 88 channels
of /O @ 1FS over a single CAT5e or CAT6 cable to any other RAVENNA devices on the network.

The RAVENNA connection on the Hapi allows for not only audio, but also control and sync information
to flow through as well. Send Timecodes and Wordclock directly to the Hapi unit over the same network
as your audio. The RAVENNA port even provides for remote control access to the configuration and
entire routing of the unit itself! Support for: LTC/Video Ref/WCK

RAVENNA is a layer 3 IP based protocol. In environments where existing networks are already in
place, RAVENNA subnets can slip right into place with no additional outlay. In laymen’s terms, this
means that you can connect your Hapi to a properly configured network exactly as you would your PC
or Mac, with no additional technology required.

RAVENNA is a “mission critical” protocol, meaning that is has been designed to ensure immensely low
jitter rates and latencies (sub-millisecond) and ensures that every single sample gets to where it needs
to go without fail. Hapi MKII provides a secondary (RJ45), redundant RAVENNA connection for
uninterrupted use, even when a network connection fails, it can also be used in switch mode.

Refer to the RAVENNA User Guide and the MassCore-RAVENNA Configuration Guide for more details

AVIERGING
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HAPI MKII - Block Diagram

Hapi Mkl hardware block diagram

Ultra low noise oscillator
33.3333MHz g
90- 230 VAG | 50-60Hz
Power supply
10-14 VDG
(optional)

CPUD CFPUA1
666MHz BEEMHZ
A
GEEMHz Y

> Memoary arbiter

1.8"0LED

display

DDR3

Clock generator

Ethernet RJ45 ( ;
RAVENNA | AESBT
Gigabit
Ethernet RJ45 Ethernet switch
RAVENMNA | AESET

RAVEMNNA

Acceleration

Wordelock infout

Video ref

LTC inout

Expansion Slot

O 000

(AD, DA, ADA, PTG4)

Expansion Slot

(AD, DA, ADA, PTG4)

‘AMERGING

AUDIO FOR THE NETWORKING AGE

ZMAN

533MHz

Headphone modulg|

'O Headphone

‘O AES infout

k.
»  Sync module AES module
[ [
»
Router/ PeakMeter
Slot 1 madule ADATISPDIF
(optional module
Slot 2 module MADI module
(optional (optional)

‘Q ADAT/ SPDIF infout
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HAPI MKII - Hardware

FRONT PANEL

5\
“ MIERGING EHIARD pasn

BACK PANEL
[' ﬁ n&]«) <. A MERGING BHAPIMII —_—
€)Y - } |

HAPI UNIT

HAPI SCHEMATIC IMAGES

Front Panel
= O o
78 MIEREINGE = [RI2A20 Wi O
Back Panel
M=o Jo[ T o ©® aore o
~N [= 8, ) SYNC - O \—‘O OH L‘O ‘“'{‘4‘./
OWO o Jo o o] e o] e O
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HAPI BASE UNIT

IOC-HAPI Specifications

Case Material

Front Panel Material

Weight (excluding redundant PS)
Dimensions (1U rack mounting)
Voltage (AC)

Voltage (DC) (option IOC-HAPI-PSR)
Power Consumption (Max)

Front Panel TFT size/resolution

Headphone Monitor Jacks

Headphone Jack 1&2

Dynamic Range (A-weighted, typ.) High / Low
Max output Level High / Low

Max output Power

Frequency response +0/-0.2dB @ fs = 48 kHz
Frequency response +0/-3dB @ fs = 96 kHz
Frequency response +0/-3dB @ fs = 192 kHz
Output Impedance

THD+N 1 kHz @ 0 dBFS High / Low
Attenuation Range (Software controlled)

Gain Step/Precision

DXD Support

DSD Support

SYNC Connectors

“Sync” Cable (LTC/Video Ref)

LTC In & Out (via “Sync” Cable)

Video Reference In (via “Sync” Cable)

Word Clock Input (Switchable 75 Q Termination)
Word Clock Output (Zout = 35 Q)

Maximum supported deviation

RAVENNA module
RAVENNA Primary / Secondary (GbE)

AES-EBU module
AES type/pinout
AES i/o

Output Impedance

MADI module
MADI types (Coaxial / Optical)
Output Impedance

ADAT/SPDIF module
ADAT/SPDIF

Software Specifications
RAVENNA MassCore Driver
Windows Driver/OS

Mac Driver/OS

Powder Coated Steel
Brushed Aluminum
45kg /10 Ibs

483 x 320 x 44 mm
100V-240VAC, 50-60 Hz
10-14VDC

< 30 Watts

OLED (160x128 px)

6.35mm (%4’) & 3.5mm TRS Female Stereo
<-118dB

15 dBu /7.3 dBu (load 600/16 Q)
2 x 200 mW (load 16 Q)

6 Hz — 22 kHz

2 Hz-44.2 kHz

2 Hz - 88.1 kHz

200

< -106 dB (0.0005%)
-»to12dB

0.5dB/10.05dB

Native

DSD 64 to DSD 256

D-Sub 15Pin
Balanced XLR
BNC

BNC, 0.5Vp-p min
BNC, 5Vp-p
+/-1000ppm

RJ45

DB-25 / AES59 (Tascam Dig.)
Grounded and transformer coupled
110 Q

BNC/SC
75Q

Optical Toslink

Pyramix v12.0 or Higher / Win7 or Win10 64bit
ASIO 2.2 / Win7 or Win10 64bit
CoreAudio / MacOS 10.13 or higher

AVIERGING :] www.merging.com/hapi
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HAPI - Optional Cards

IOM-H-AKDG8D / AKDG8DP

These remotely controlled Mic/Line Input cards are 3rd generation Dual Gain topology designs, inspired
from the Anubis outstanding Preamps, that show zero tolerance to any compromise on the audio

quality.

A new benchmark in analog circuitry design, and provide additionally a Line level post Mic-pre “Direct

Out” output.

Available in models that work up to 192kHz (AKDG8D) and DXD/DSD256 (AKDG8DP)

ST s s st
J ~"1ﬁ:r.gf‘w Ees
" ’ B

(s

IOM-H-AKDGS8D / AKDG8DP Key Features

* 8 x exceptionally transparent, Swiss designed pre-amplifiers
* Remote/Local switch to Line Level on a per channel basis

» Completely accessible remotely for all parameter changes

» Phantom Power/Polarity Invert/Low Cut/Impedance switchable per channel

* Removes the need for DI boxes

* Allows build-in Mic splitting variants

» Dynamic range of 136dB (A-weighted, typ)
 Auto-mute circuitry for “no-pop” power cycling

IOM-H-AKDGS8D / AKD8GDP Mic Pre-Amp + ADC
Mic Pre Max Input (Mic+Pad / Mic / Boost)

Mic Pre Max Input (Pad On; Pad Off)

Input Impedance (Zlo; ZHi)

Dynamic Range (flat 20 Hz-20 kHz)

Dynamic Range (A-weighted, typ)

Gain Range (software controlled)

Gain Precision

Gain Step

THD+N Pre + A/D (20 Hz-20 kHz) @ -2 dBFS
Interchannel Crosstalk @ 1kHz, typ.

Interchannel Crosstalk @ 20Hz — 20 kHz

EIN @ >40 dB Gain (150Q Source Impedance, A-weighted, typ)
Common Mode Rejection Rate @ 1kHz, typ.

Common Mode Rejection Rate @ 20Hz — 20 kHz
Phantom Power (Software Switchable Per Channel)
Phase Reverse Switch (Software Switchable Per Channel)
Low Cut filter (Software Switchable Per Channel)

IOM-H-AKDG8D/ADDGSDP Line input Section

AVIERGING
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+24 dBu/ +12 dBu/ +0 dBu
>3 kQ; 10.4 kQ

>3 kQ; 10.4 kQ

> 134 dB

136 dB

0 dB to +66 dB

+0.2 dB

0.5dB

-110 dB (0.00031 %)/-112 dB (0.00025 %)
<-125dB

<-100dB

-128 dBu

75 dB (up to -20 dBFS)

> 60 /65 dB (up to -20 dBFS)
+48 Volts

Yes

-12 dB/octave, 80 Hz
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Frequency response +0/-0.1dB @ fs = 44100 Hz
Frequency response +0/-1.0dB @ fs = 44100 Hz
Frequency response +0/-0.1dB @ fs = 96000 Hz
Frequency response +0/-1.0dB @ fs = 96000 Hz
Frequency response +0/-0.1dB @ fs = 192000 Hz
Frequency response +0/-1.0dB @ fs = 192000 Hz
Frequency response +0/-0.1dB @ fs = 384000 Hz
Frequency response +0/-1.0dB @ fs = 384000 Hz
Max Line Input for 0 dBFS

Input Impedance

Dynamic Range (flat 20 Hz-20 kHz), ref +24 dBu
Dynamic Range (A-weighted, typ), ref +24 dBu
THD+N Line+A/D (1 kHz) @ -2 dBFS, Typ.
THD+N Line+A/D (20 Hz-20 kHz) @ -2 dBFS
Interchannel Crosstalk @ 1kHz, typ.

Interchannel Crosstalk @ 20Hz — 20 kHz
Sensitivity Range for 0 dBFS (software controlled)
Gain Precision

Gain Step

Common Mode Rejection Rate @ 1kHz, typ.
Common Mode Rejection Rate @ 20Hz — 20 kHz
Group Delay (1FS)

Group Delay (2FS)

Group Delay (4FS) / Premium (8FS)

IOM-H-AKDG8D / AKDG8DP Direct Out Section

Max Direct Output level typ.
Output Impedance (Differential)
THD+N (1 kHz) @ +10dBu
Input Connector Pinout

Direct Output Connector Pinout

5.7 Hz - 20.5 kHz

1.8 Hz - 21.0 kHz

5.7 Hz - 43.9 kHz

1.8 Hz - 45.4 kHz
5.7Hz-42.1 kHz

1.8 Hz - 64.7 kHz

5.7 Hz — 40 kHz

1.8 Hz - 75 kHz

+24 dBu

10.4 kQ

> 136 dB

138.5dB

-106 dB (0.0005%)/-109 dB (0.00035%)
<-106 dB

-130 dB

<-100dB

-42 dBu to +24 dBu
+0.2 dB

0.5dB

75 dB (up to -20 dBFS)
> 65 dB (up to -20 dBFS)
5/fs

5/fs

6/fs | 7/fs

+24 dBu / +12 dBu / +0 dBu
<100 Q

<-111dB (0.00028 %)

DB-25 / AES59 (Tascam Ana.)
DB-25 / AES59 (Tascam Ana.)

IOM-H-AKDG8D / AKDG8DP Dual preamp block diagram

| IOM-H-AKDG8DS/AKDG8DP Dual PreAmp input diagram |

Advanced
i Low cut }—"1 Digital gain L/A (DSD only) |_>
DG remover

FPGA Dual PreAmp
- 32bits - ‘L
Gain +4dB —»{Amanuannn 21dB}—P|DC remover|
=
|| 32bits,
PreAmp At -17d8 AD
- =

AVIERGING :] www.merging.com/hapi
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IOM-H-AKDG8D/AKDGS8DP block diagram

\ Data flow in PCM on AKDG8DS/AKDGSDP cards

Direct Out < -24dB
48\ phantom " Freamp
Analog input > power > :i‘gs?;?i;) > analog gain »  A/D converter
On / Off s Line / Mic+Pad / Mic / Mic Boost

3k(2 Dynamic Mic
10.4k{2: Line Input 32 bits

DC remover > Digtal gain + »  PCM output
low cut filter

52 Bits for integrator

Data flow in DSD on AKDG8DP cards

Direct Out -24dB
‘ 4BV phantom - Zin selector - PrEﬂmD. | AJD converter
Analog input > power 2K/ 10.4kD2 analog gain >
On / Off oIk Line / Mic+Pad / Mic / Mic Boost
3k02: Dynamic Mic
10.4k0: Line Input
DC Remover »| Digital gain + > LA Modulator > DSD output
low cut filter
1 bit

Note: The AKDG8DS/P cards do not reflect on their Direct Outs the Digital Gain values which are only applied to
the local signal paths. They offer a fixed level output, and do reflect the Line/Mic/Boost respective Analog front-end
gains. Which are 0 dB for Line (and Mic with PAD), 12 dB for Mic and 24 dB for Boost settings.

‘AMERG'NG :] www.merging.com/hapi
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IOM-H-AKD8D / AKD8DP

These remotely controlled Mic/Line Input cards have set a new benchmark in analog circuitry design,
and provide additionally a Line level post Mic-pre “Direct Out” output.
Available in models that work up to 192kHz (AKD8D) and DXD/DSD256 (AKD8DP)

IOM-H-AKD8D / AKD8DP Key Features

* 8 x exceptionally transparent, Swiss designed pre-amplifiers

* Remote/Local switch to Line Level on a per channel basis

» Completely accessible remotely for all parameter changes

» Phantom Power/Polarity Invert/Low Cut switchable per channel
* Removes the need for DI boxes

* Allows build-in Mic splitting variants

* Better than 120dB dynamic range

IOM-H-AKD8D / AKD8DP Mic Pre-Amp + ADC

Mic Pre Max Input (Pad On / Pad Off)

Input Impedance (Differential, Software Switchable Per Channel)
Input Impedance with +48V ON (Diff., Soft. Switchable Per Channel)
Dynamic Range (A-weighted, typ.) , ref +10 dBu

Gain Range (software controlled)

Gain Step/Precision

THD+N Pre + A/D (20 Hz-20 kHz) @ -2 dBFS (AD8/AD8P)
Interchannel Crosstalk @ 1kHz, typ.

EIN @ >40 dB Gain (150Q Source Impedance, A-weighted, typ.)
Common Mode Rejection Rate (20 Hz — 20 kHz)

Phantom Power (Software Switchable Per Channel)

Polarity Invert (Software Switchable Per Channel)

Low Cut filter (Software Switchable Per Channel)

Line Input

Max Line Input for 0 dBFS

Input Impedance (Differential)

Dynamic Range (A-weighted, typ), ref +24 dBu
THD+N Line+A/D (20 Hz - 20 kHz) @ -10 dBFS
Interchannel Crosstalk @ 1kHz @ fullscale
Sensitivity Range for 0 dBFS (software controlled)
Gain Step/Precision

Common Mode Rejection Rate (20 Hz — 20 kHz)
Connector Pinout

AMERGING [
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+24 dBu / +13 dBu
1.9kQ /10 kQ

1.9kQ /10 kQ
123.5dB

0 dB to +66 dB
0.5dB/+0.2dB
<-110dB (0.00031%)/-111dB (0.00028%)
<-125dB

<-128 dBu

> 60 dB (up to 0 dBFS)
+48V

YES

-12 dB/octave, 80 Hz

+24 dBu

10 kQ

124 dB

<-110dB (0.00031%)/-111dB (0.00028%)
<-130dB

-42 dBu to +24 dBu

0.5dB/+0.2dB

> 60 dB /> 65dB (both up to 0 dBFS)
DB-25 / AES59 (Tascam Ana.)
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IOM-H-AKD8D / AKD8DP Mic-Pre Analog Section
Frequency response +0/-0.5 dB, Line

Frequency response +0/-2.0 dB, Line

Frequency response +0/-0.5 dB, Mic, at G=40dB
Frequency response +0/-2.0 dB, Mic, at G=40dB
THD+N (1 kHz), Line/Mic at G=0dB

THD+N (20 Hz-20 kHz) , Line/Mic at G=0dB
Interchannel Crosstalk @ 1kHz, typ.

5° low-end in-channel @ deviation pt: Line

5° low-end in-channel & deviation pt: Mic
Interchannel phase 10 Hz - 100 kHz

IOM-H-AKD8D / AKD8DP Direct Out Section
Frequency response +0/-0.5dB @ Gain 40dB

Max Direct Output level typ.

Output Impedance (Differential)

Dynamic Range (20 Hz — 22 kHz, typ)

THD+N (1 kHz) @ +10dBu

Input Connector Pinout

Direct Output Connector Pinout

Gain behavior of the Direct Out section

2 Hz - > 200 kHz

1 Hz - > 200 kHz

2 Hz - 65 kHz

1 Hz - 160 kHz

<-115 dB (0.00018 %)
<-112 dB (0.00025 %)
-140dB

9 Hz

9 Hz

<0.1°

2 Hz — 65kHz

+24 dBu / +13 dBu

<100 Q

140 dB

<-120dB (0.0001 %)

DB-25 / AES59 (Tascam Ana.)
DB-25 / AES59 (Tascam Ana.)

As the Direct Out output is taken just after the Mic-pre analog section, the gain adjustments are not as
smooth and linear as after the digital conversion. The figure below shows the behaviour of the gain on
the Direct Out (in blue) compared to the gain on the digital side (in red).

Note: on the Direct Out the maximum available gain is + 40.1 dB.

60

50

40

Out

30

20

= Digital gain available at AD
output

10

50

60
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IOM-H-AKD8D/AKD8DP block diagram

‘Data flow in PCM on AKD8DP cards (run 12 and above

Direct Out
Analog output  [(%€—— Mic (no pad) +13dBu
Mic (pad) / Line +24dBu
28V phantom ) Preamp o
. Zin selector . Mic / Line pad
Analog input > power > | , »  analog gain > y »  A/D converter
Cn / Off 2k0D / 6.8k (2 / 10kO| 0 to +40dB 11dB
2kL): Dynamic Mic (na phantom)
.80 Cardenser Mic {phantom) 24 bils

10KLY: Lina Input

PCM output

Digital gain +

BB low cut filter

36 bits for integrator

24 bits,

Data flow in DSD on AKD8DP cards (run 12 and above)

Direct Out
Analog output  [€——{ Mic (no pad) +13dBu
Mic (pad}/ Line +24dBu
48V phantom 1 Preamp N 4
. Zin selector . Mic / Line pad AJD converter
Analog input power | i - —»  analog gain > .
Ry 2k0 [ B.8kD) / 10.4K0 e -11dB 1 bit

2KL): Dynamic Mic (no phaniom)

68K0): Condanser Mic {phantom)

10.4kC): Lina Input
Decimation filter Decimatar Low pass fitter DC remaver Digital gain > S‘Q..T;dg?lta > DSD output

14 bits. 36 bits. 27 bits 41 bits for integrator 32 bits 1 bit

‘AMERGING +|
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IOM-H-AD8D / AD8DP - Legacy Product

These remotely controlled Mic/Line Input cards have set a new benchmark in analog circuitry design,
and provide additionally a Line level post Mic-pre “Direct Out” output.
Available in models that work up to 192kHz (AD8D) and DXD/DSD256 (AD8DP)

e

i i
it

IOM-H-ADS8D / AD8DP Key Features

+ 8 x exceptionally transparent, Swiss designed pre-amplifiers

* Remote/Local switch to Line Level on a per channel basis

» Completely accessible remotely for all parameter changes

» Phantom Power/Polarity Invert/Low Cut switchable per channel
* Removes the need for DI boxes

* Allows build-in Mic splitting variants

« Better than 120dB dynamic range

IOM-H-ADS8D / AD8DP Mic Pre-Amp + ADC

Mic Pre Max Input (Pad On / Pad Off)

Input Impedance (Differential, Software Switchable Per Channel)
Input Impedance with +48V ON (Diff., Soft. Switchable Per Channel)
Dynamic Range (A-weighted, typ.) , ref +13 dBu

Gain Range (software controlled)

Gain Step/Precision

THD+N Pre + A/D (20 Hz-20 kHz) @ -2 dBFS (AD8/AD8P)
Interchannel Crosstalk @ 1kHz, typ.

EIN @ >40 dB Gain (150Q Source Impedance, A-weighted, typ.)
Common Mode Rejection Rate (20 Hz — 20 kHz)

Phantom Power (Software Switchable Per Channel)

Polarity Invert (Software Switchable Per Channel)

Low Cut filter (Software Switchable Per Channel)

Line Input

Max Line Input for 0 dBFS

Input Impedance (Differential)

Dynamic Range (A-weighted, typ), ref +24 dBu
THD+N Line+A/D (20 Hz - 20 kHz) @ -12 dBFS
Interchannel Crosstalk @ 1kHz @ fullscale
Sensitivity Range for 0 dBFS (software controlled)
Gain Step/Precision

Common Mode Rejection Rate (20 Hz — 20 kHz)
Connector Pinout

AMERGING [
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+24 dBu/ +13 dBu
2kQ/13.6 kQ

1.7 kQ /6.8 kQ

120.5 dB

0 dB to +66 dB
0.1dB/+0.2dB

< -96dB (0.0016 %)/ -100 dB (0.001 %)
<-125dB

<-128 dBu

> 60 dB (up to 0 dBFS)
+48V

YES

-12 dB/octave, 80 Hz

+24 dBu

13.6 kQ

121 dB

<-100 dB (0.001%)

<-120dB

-42 dBu to +24 dBu
0.5dB/+0.2dB

> 60 dB (up to 0 dBFS)

DB-25 / AES59 (Tascam Ana.)
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IOM-H-AD8D/AD8DP Mic-Pre Analog Section

Frequency response +0/-0.5 dB, Line
Frequency response +0/-2.0 dB, Line
Frequency response +0/-0.5 dB, Mic
Frequency response +0/-2.0 dB, Mic
THD+N (1 kHz), Line/Mic at G=0dB

THD+N (20 Hz-20 kHz) , Line/Mic at G=0dB
Interchannel Crosstalk @ 1kHz, typ.

5° low-end in-channel @ deviation pt: Line
5° low-end in-channel & deviation pt: Mic
Interchannel phase 10 Hz - 100 kHz

IOM-H-AD8D/ADS8DP Direct Out Section
Frequency response +0/-0.3dB @ Gain 40dB
Max Direct Output level typ.

Output Impedance (Differential)

Dynamic Range (A-weighted, typ)

THD+N (1 kHz) @ +10dBu

Input Connector Pinout

Direct Output Connector Pinout

Gain behavior of the Direct Out section

5Hz-75kHz

2.5 Hz - 150 kHz

10 Hz - 100 kHz

5 Hz - 200 kHz
<-115dB (0.00018 %)
<-112 dB (0.00025 %)
-135dB

13 Hz

35 Hz

<%0.1°

10 Hz —50kHz
+24 dBu/ +13dBu
<100 Q

133 dB

<-120dB (0.0001 %)

DB-25 / AES59 (Tascam Ana.)
DB-25 / AES59 (Tascam Ana.)

As the Direct Out output is taken just after the Mic-pre analog section, the gain adjustments are not as
smooth and linear as after the digital conversion. The figure below shows the behaviour of the gain on
the Direct Out (in blue) compared to the gain on the digital side (in red).

Note: on the Direct Out the maximum available gain is + 40.1 dB.
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IOM-H-AD8D/ADS8DP block diagram

Data flow in PCM on AD8DP cards (run 1 to 8)

Direct Out
Anslog output 1< e ine +180Bu
A ‘ 48V phantom Mic / Line pad Preampl )
nalog input power Y analog gain AJD converter
On { Off 0 to +40dB
2K0) Mic input

24 bits.

&.9k0); Line Input

FPGA

DC remo

Digital gain +
e low cut filter PCM output

24 bits,

38 bits for integrator

‘ Data flow in PCM on AD8DP cards (run 9 and above) ‘

Direct Out
|[€— Mic {no pad) +13dBu

Analog output
Mic (pad) / Line +24dBu
Analoginput wv;rfenrmm ZHssbcios E;ﬁi‘émgiin LS AID converter
On J Off 2kC2 / 6.8k / 13kQ) 0 1o +40dB -11dB

2k Dynarmic Mic (no phantom)

6.5k(): Condenser Mic (phartam) 24 bits

13k0): Line Input

DC remover Digital gain - PCM output
low cut filter
38 bits for integrator 24 hits.
Direct Qut
Analog output [ €—— Mic (no pad) +13dBu
Mic {pad) / Line +24dBu
Anslog input 5| 9 Fanom Zin selector a:;’;:“;gin Mic  Line pad AID comverter
On Off 2k} / 6.8k / 13kQ) 010 +40dB -11dB 6 bits
2k Dynarmic Mic {na phantom)
.80 Candenser Mic (phaniom)
13KEL: Ling Input
o o § - . Sigma Delta iy
Decimation filter Decimator Low pass filter DC remover Digital gain “+8dB" DSD output
14 bits 8 hits 26 bits. 36 bits for integrator 32 bits 1 bit

‘AMERG'NG 3 wwwmerg
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IOM-H-DAS8/DAS8P (>=run 11)

The DAS8 (up to 192kHz) and the DAS8P (up to DSD) have been shown in testing to be consistently the
quietest multichannel D/A conversion modules available anywhere.

IOM-H-DA8/DA8P Key Features

* Auto-mute circuitry for “no-pop” power cycling
* Digitally controlled trims for line up procedures
* Dynamic range of 127dB (typ.)

* Local low phase noise oscillator circuitry

IOM-H-DA8/DAS8P Specifications

Max Line Output @ 0 dBFS (settings on +24 dBu) +25 dBu +0/-0.5 dB
Frequency response +0/-0.3dB @ fs = 48000 Hz 0 Hz-20 kHz

Frequency response +0/-0.3dB @ fs = 2.8224 MHz (DSD) NA /0 Hz - 20 kHz

Frequency response +0/-3.0dB @ fs = 2.8224 MHz (DSD) NA /0 Hz - 50 kHz

Line Output Impedance (Differential) 90 Q

Dynamic Range (A-weighted, typ) 127 dB

THD+N D/A (1 kHz) @ 0 dBFS (IOM-HORUS-DAS8) <-113dB (0.00022 %)

THD+N D/A (1 kHz) @ 0 dBFS (IOM-HORUS-DAS8P) <-116dB (0.00016 %)
Interchannel Crosstalk @ 1kHz, typ. -140 dB

Connector Pinout DB-25 / AES59 (Tascam Ana.)

Line Output Level calibration
On the DA8 and DAS8P cards, the output level setting for all channels is done via software through the
option “max output level” in each DA’s setting page, allowing either + 24 dBu or 18 dBu max level.

For a more precise trimming of the output level, the output attenuation can be set on the same page

Output Attenuation: -3.0 dB

The Hapi software Output Attenuation range is from -60dB to 0dB

AVIERGING

:] www.merging.com/hapi
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How to connect the symmetrical line out to an unbalanced input
Never attempt to short pin 3 (or pin 2) to Ground on Hapi DA's output, since the Hapi Line Out driving
circuitry is symmetrical but not floating.

Unbalanced

Hi

RCA )

Shield

Unbalanced

Hi

Rea @)

Shield

Balanced

/\

BAD

Balanced

Lo {not connected)

GOOD

Shield

Shield

XLR

XLR

Furthermore, as Unbalanced Inputs are traditionally more sensitive than Balanced Inputs, the - 6dB
Analog level achieved by using only one of the Hapi symmetrical outputs, will offer better signal level
adaptation with less risks of overdriving the Unbalanced Inputs connected to the Hapi.

IOM-H-DAB8/DAS8P block diagram.

DAS8 / DA8P
Digital input Digital Analog Output Level Analog Output
Output Attenuation > Roll Off Filter I> D/A converter > Selection > Mute Switch —_—)
[0 .. -60dB] +18dB/+24dB
AMERG'NGH www.merging.com/hapi
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IOM-HORUS-DAS8/DAS8P (< run 11) - Legacy product

The DAS8 (up to 192kHz) and the DAS8P (up to DSD) have been shown in testing to be consistently the
quietest multichannel D/A conversion modules available anywhere.

IOM-HORUS-DAS8/DAS8P Key Features

* Auto-mute circuitry for “no-pop” power cycling

« Digitally controlled trims for line up procedures

* Dynamic range of 127dB (typ.)

* Easy to set dip switches for international operating levels

IOM-HORUS-DAB8/DAS8P Specifications

Max Line Output @ 0 dBFS (jumpers on +24 dBu) +24 dBu +0/-0.5 dB
Frequency response +0/-0.3dB @ fs = 48000 Hz 0 Hz - 20 kHz

Frequency response +0/-0.3dB @ fs = 2.8224 MHz (DSD) NA /0 Hz - 20 kHz

Frequency response +0/-3.0dB @ fs = 2.8224 MHz (DSD) NA /0 Hz-50 kHz

Line Output Impedance (Differential) 100 Q

Dynamic Range (A-weighted, typ) 126 dB

THD+N D/A (1 kHz) @ 0 dBFS (IOM-HORUS-DAS8) < -113dB (0.00022 %)

THD+N D/A (1 kHz) @ 0 dBFS (IOM-HORUS-DAS8P) <-115dB (0.00018 %)
Interchannel Crosstalk @ 1kHz, typ. -135dB

Connector Pinout DB-25 / AES59 (Tascam Ana.)

Line Output Level calibration

The DA8 and DA8P modules feature both hardware level settings and a software fine adjustment to
align the Analog Output levels to whatever local/organization operational levels are mandated.

On DA8/DAB8P cards from run 7 upwards, the hardware level setting is done via software through the
option “max output level” in each DA’s setting page, allowing either + 24 dBu or 18 dBu max level.

On DA8/DAB8P cards prior to run 7 the hardware level setting is in the form of 4 DIP switches per output
channel

The Hardware settings will usually be set only once, at product installation, and only if the desired
Operating Line Level differs from the default ex-factory settings of +18 dBu for 0 dBFS.

Procedure for Hardware alignment (for DA8 prior to run 7):

1. Shut down your Horus and make sure that the Horus back panel Power is also switched OFF.

2. Unscrew all DA8 modules that need adjustment.

3. Pull gently out (5-7 cm is enough) to access the DIP Switches. There is one block of 4 dip switches
per channel. Channel 1 is labeled S1, channel 8 is labeled S8.

AVIERGING
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Output Level (dBu)

+24 +18 +15 +12

1 ON ON

Switch | 2 ON ON
S1to S8 3 ON ON
4 ON ON

Output Level calibration Example:

Assuming your operating Level is 21 dBu for 0 dBFS (typical of French Radio Broadcasters), you
should set the DIP Switches all OFF (DIP Switch positioned to the left, with respect to the picture
below) to set maximum Output Level to +24 dBu (since there is no 21 dBu hardware setting)

Once this is set and the DA modules are screwed back in place. Power up the Horus and go to the
Horus Setup Page>Module, select each D/A module for software calibration.

AVIERGING
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In this example case set the software attenuation to - 3 dB (see image below), so the overall result ends
up at 21 dBu for a Full Scale signal

Output Attenuation: -3.0 dB

The Hapi software Output Attenuation range is from -12dB to 0dB

How to connect the symmetrical line out to an unbalanced input
Never attempt to short pin 3 (or pin 2) to Ground on Horus DA's output, since the Horus Line Out driving
circuitry is symmetrical but not floating.

Unbalanced Balanced Hi

Hi

fea (0)} ) /\

= :
- / BA D \ Shield

XLR

Unbalanced

RCA )
| P
Shield

- GOOD Shield

Lo {not connected)

Balanced Hi

XLR

Furthermore, as Unbalanced Inputs are traditionally more sensitive than Balanced Inputs, the - 6dB
Analog level achieved by using only one of the Horus symmetrical outputs, will offer better signal level
adaptation with less risks of overdriving the Unbalanced Inputs connected to the Horus.
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IOM-HORUS-DAS8/DAS8P block diagram

DA8 /DASPrun1torun6
Digital input Digital Analog ?utr.mt Level Analog Output
—————————— % Output Attenuation > Roll Off Filter —  D/A converter Spcction Mute Relay —
0 .. -60d8] +12dB/+15dB/
. +18dB/+24dB
DAS8 / DASP run 7 and above
Digital input Digital Analog Output Level Analog Output
———— > Output Attenuation > Roll Off Filter > D/A converter Selection Mute Switch —_—)
[0 ..-60dB] +18dB/+24dB

‘AMERGING +|
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IOM-H-ADA8S/ADASP

These remotely controlled Mic/Line Input and Output cards are 3™ generation Dual Gain topology
designs, inspired from the Anubis outstanding Preamps, that show zero tolerance to any compromise

on the audio quality.

Available in models that work up to 192kHz (ADA8S) and DXD/DSD256 (ADA8P)

Using those combined 8 channel Mic/Line In and Line Out cards allow the Hapi to be configured with up

to 16 channels of Analog In/Out.

~e—
RRLELE Y

A
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IOM-H-ADA8S/ADAS8P Key Features

* 8 x exceptionally transparent, Swiss designed pre-amplifiers

» Remote/Local switch to Line Level on a per channel basis
» Completely accessible remotely for all parameter changes

» Phantom Power/Polarity Invert/Low Cut/Impedance switchable per channel

» Dynamic range of 139dB (A-weighted, typ) on the Line inputs

 Auto-mute circuitry for “no-pop” power cycling
* Digitally controlled output trims for line up procedures

» Dynamic range of 124dB (A-weighted, typ.) on the Line outputs

IOM-H-ADA8S/ADABSP Specifications

IOM-H-ADA8S/ADAS8P Mic-Pre + ADC Section
Mic Pre Max Input (Mic+Pad / Mic / Boost)

Input Impedance (Differential, Software Switchable Per Channel)

Input Impedance (Zlo; ZHi)

Frequency response +0/-0.3dB @ fs = 48 kHz
Frequency response +0/-3dB @ fs = 96 kHz
Frequency response +0/-3dB @ fs = 192 kHz

Dynamic Range Mic (A-weighted, typ.), ref +12 dBu
Dynamic Range Mic Boost (A-weighted, typ.), ref 0 dBu
Gain Range (software controlled)

THD+N Pre + A/D (20 Hz - 20 kHz) @ -2 dBFS
Interchannel Crosstalk @ 1kHz

EIN @ >40 dB Gain (150Q Source Impedance, A-weighted)
Common Mode Rejection Rate (20 Hz — 20 kHz)
Phantom Power (Software Switchable Per Channel)
Polarity Invert (Software Switchable Per Channel)

Low Cut filter (Software Switchable Per Channel)

AVIERGING :] www.merging.com/hapi
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+24 dBu/ +12 dBu/ +0 dBu
3ka/10.4 kQ
3ka/10.4 kQ

9 Hz — 22 kHz

9 Hz — 46 kHz

11 Hz — 94 kHz

137 dB

128 dB

0 dB to +66 dB

<-111 dB (0.00028 %)
<-130dB

<-127 dB

>75dB

+48V

YES

-12 dB/octave, 80 Hz
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IOM-H-ADA8S/ADAGSP Line input Section
Max Line Input for 0 dBFS

Input Impedance (Differential)

Dynamic Range (A-weighted, typ.), ref +24 dBu
THD+N Line+A/D (20 Hz - 20 kHz) @ -2 dBFS
Interchannel Crosstalk @ 1kHz

Sensitivity Range for 0 dBFS (software controlled)
Gain Step

Common Mode Rejection Rate (20 Hz — 20 kHz)
Connector Pinout

IOM-H-ADA8S/ADASP Line Out Section

Max Output level software switchable for 0 dBFS
Frequency response +0/-0.3dB @ fs = 48 kHz
Frequency response +0/-3dB @ fs = 96 kHz
Frequency response +0/-3dB @ fs = 192 kHz
Output Impedance (Differential)

Dynamic Range (A-weighted, typ.)

THD+N (1 kHz) @ 0dBFS

Interchannel Crosstalk @ 1kHz

Connector Pinout

IOM-H-ADA8S/ADAS8P Dual preamp block diagram

+24 dBu

10.4 kQ

139 dB

<-111 dB (0.00028 %)
<-135dB

-42 dBu to +24 dBu

0.5dB

>70dB

DB-25 / AES59 (Tascam Ana.)

+24 dBu / +18 dBu +0/-0.5 dB
0 Hz — 22 kHz

0 Hz - 46 kHz

0 Hz-92 kHz

<800Q

125dB/ 126 dB

<-115dB (0.00017 %)
<-139dB

DB-25 / AES59 (Tascam Ana.)

\ IOM-H-ADA8S/ADASP Dual PreAmp input diagram

FPGA Dual PreAmp

32bits
Gain +4dB

32bits

E] [E[e] 5]

Att. -17dB AD

Low cut }—)—1 Digttal gain £/A {DSD only) ’—b
-
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IOM-H-ADA8S/ADAB8P block diagram

Data flow in PCM on ADA8S/ADAS8P cards

‘AMERGING +|

AUDIO FOR THE NETWORKING AGE

* The ADA8P run 5 do not have Low Cut option

www.merging.com/hapi

A8V phantom Al Preamp
Analog input > power > 30D/ 10.4K0D > analog gain > A/D converter
On / Off P Line / Mic+Pad / Mic / Mic Boost
3kL): Dynamic Mic
10.4kLE Lina Input 32 bits
DC remover > I »  FCMoutput
low cut filter
52 Bits for integrator
* The ADAS8P run 5 do not have Low Cut option
. -l ARy P ey -~ Zin selector Preampl w| A/D converter
Analog input > power > a0/ 10.4K0 > analog gain >
On / Off o Line / Mic+Pad / Mic / Mic Boost
3kL): Dynamic Mic
1040k Lina Input
DC Remaover > Digital gain + > Z/A Modulator : g DSD output
low cut filter

1 bit
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ADAS8S and ADASP Roll Off Filters:

Sharp: Offers a flat frequency response with an attenuation of 3 dB at 0.484 x FS (23.2 kHz @48Kk),
which has the tradeoff of 35 samples latency.

|Leqend Il FastRoll-Off (Linear) |

Fast Roll-Off, Linear Phase
Filter (dB) %0

Slow (default): Offers the lowest latency of 9 samples, with the tradeoff of a gentle frequency response
attenuation reaching -3dB at 0.45 x FS (21.6 kHz @48k)

[Legena H SlowRoll-Off (Linear) ]

Slow Roll-Off, Linear Phase
Filter (dB)

Apodizing: Fast Roll-Off filter, Linear phase filter. Latency of 35 samples

|Legend W Apodizing 1 (Linear) |

Apodizing, Fast Roll-Off,
Linear Phase Filter (dB)

apodizing1 "

Brickwall: Ensures rejection of more than -100dB at Nyquist (0.50 x FS, 24 kHz @48k). Latency of 35
samples

[Legend: M Brick wall (Linean |

Brickwall Filter (dB)
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IOM-H-ADAS - Legacy Product

These remotely controlled Mic/Line Input and Output cards have broken a new barrier in terms of
compactness as well as ultra-low power consumption without compromising on the audio quality.

These cards work at sampling rates up to 192 kHz

Using those combined 8 channel Mic/Line In and Line Out cards allow the Hapi to be configured with up

to 16 channels of Analog In/Out.

Yiias

aranaianasanaian

* 8 x exceptionally transparent, Swiss designed pre-amplifiers

* Remote/Local switch to Line Level on a per channel basis
» Completely accessible remotely for all parameter changes

» Phantom Power/Polarity Invert/Low Cut/Impedance switchable per channel

» Dynamic range of 120dB (A-weighted, typ) on the Line inputs

* Auto-mute circuitry for “no-pop” power cycling
* Digitally controlled output trims for line up procedures

» Dynamic range of 123dB (A-weighted, typ.) on the Line outputs

IOM-H-ADAS8 Specifications

IOM-H-ADAS8 Mic-Pre + ADC Section
Mic Pre Max Input (Pad On / Pad Off)

Input Impedance (Differential, Software Switchable Per Channel)
Input Impedance with +48V ON (Diff., Soft. Switchable Per Channel)

Frequency response +0/-0.3dB @ fs = 48 kHz
Frequency response +0/-0.3dB @ fs = 96 kHz
Frequency response +0/-0.3dB @ fs = 192 kHz
Dynamic Range (A-weighted, typ.), ref +13 dBu
Gain Range (software controlled)

Gain Step/Precision

THD+N Pre + A/D (20 Hz - 20 kHz) @ -2 dBFS
Interchannel Crosstalk @ 1kHz

EIN @ >40 dB Gain (150Q Source Impedance, A-weighted)
Common Mode Rejection Rate (20 Hz — 20 kHz)
Phantom Power (Software Switchable Per Channel)
Polarity Invert (Software Switchable Per Channel)
Low Cut filter (Software Switchable Per Channel)

IOM-H-ADABS Line input Section

Max Line Input for 0 dBFS

Input Impedance (Differential)

Dynamic Range (A-weighted, typ.), ref +24 dBu
THD+N Line+A/D (20 Hz - 20 kHz) @ -2 dBFS
Interchannel Crosstalk @ 1kHz

Sensitivity Range for 0 dBFS (software controlled)
Gain Step/Precision

Common Mode Rejection Rate (20 Hz — 20 kHz)
Connector Pinout

AVIERGING :] www.merging.com/hapi
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+24 dBu / +13 dBu
2k0/13.6 kQ

1.7 kQ /6.8 kQ

10 Hz — 22 kHz

10 Hz — 44 kHz

10 Hz — 85 kHz
119.5dB

0 dB to +66 dB
0.5dB/+0.2dB
<-102 dB (0.0008 %)
<-125dB

<-128 dBu

> 60 dB (up to 0 dBFS)
+48V

YES

-12 dB/octave, 80 Hz

+24 dBu

13.6 kQ

120 dB

<-102 dB (0.0008%)
<-125dB

-42 dBu to +24 dBu
0.5dB/+0.2dB

> 60 dB (up to 0 dBFS)

DB-25 / AES59 (Tascam Ana.)
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IOM-H-ADAS8 Mic-Pre Analog Section
Frequency response +0/-0.5 dB, Line
Frequency response +0/-2.0 dB, Line
Frequency response +0/-0.5 dB, Mic
Frequency response +0/-2.0 dB, Mic
THD+N (1 kHz), Line/Mic at G=0dB
THD+N (20 Hz-20 kHz) , Line/Mic at G=0dB
Interchannel Crosstalk @ 1kHz, typ.

5° low-end in-channel @ deviation pt: Line
5° low-end in-channel & deviation pt: Mic
Interchannel phase 10 Hz - 100 kHz

IOM-H-ADAS Line Out Section

Max Output level software switchable for 0 dBFS
Frequency response +0/-0.3dB @ fs = 48 kHz
Frequency response +0/-3dB @ fs = 96 kHz
Frequency response +0/-3dB @ fs = 192 kHz
Output Impedance (Differential)

Dynamic Range (A-weighted, typ.)

THD+N (1 kHz) @ O0dBFS

Interchannel Crosstalk @ 1kHz

Connector Pinout

IOM-H-ADAS8 block diagram

5Hz-75kHz

2.5 Hz - 150 kHz

10 Hz - 100 kHz

5 Hz - 200 kHz
<-115dB (0.00018 %)
<-112 dB (0.00025 %)
-135dB

13 Hz

35 Hz

<%0.1°

+24 dBu / +18 dBu +0/-0.5 dB
0 Hz — 22 kHz

0 Hz — 44 kHz

0 Hz - 88 kHz

<100 Q

123 dB

<-108 dB (0.0004 %)
<-135dB

DB-25 / AES59 (Tascam Ana.)

MIC / LINE IN
Analog input g8Vbhantony - Zin selector - Prearnp. - Mic / Line pad - - - .
R power »12ka /6.8ka /13kQ » analog gain » 1548 »  A/D converter » Digital gain
On / Off : 0 to +40dB
2kQ: dynamic mic (no phantom)
6.8kQ: condenser mic (with phantom ON)
13.6kQ: line input
LINE OUT
Digital input Digital Analog Output Level Analog Output
———————— 3 Output Attenuation > Roll Off Filter » D/A converter » Selection » Mute Switch —
[0... -60dB] +18dB/+24dB

AVIERGING :] www.merging.com/hapi
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IOM-H-PT64

This module allows you to connect your Hapi directly to a Pro Tools HD or Pro Tools HDX system
through its two Digilink Mini connectors. You can plug up to two modules in a device, meaning you can

record up to 128 Channels at a time.
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IOM-H-PT64 Key Features

» Up to 64 Channels @48kHz per module (32 ch. @ 96kHz, 16 ch. @192kHz)
* Up to two IOM-H-PT64 modules in one Horus/Hapi

» Automatic Delay Compensation

* Three hardware emulation modes (Digidesign 1921/0, HDIO and HDMADI)
» Two Digilink mini connectors

Ports usage
There are two connectors on the IOM-H-PT64 module called Port 1 and Port 2.

Working at 44.1/48kHz, both Ports are enabled. Channels 1/0 1-32 are carried through Port 1 and
channels I/O 33-64 through Port 2. If only 32 channels are needed, it is possible to use only Port 1 or
only one of Port 1 or Port 2 in HD I/O or 192 I/O modes only.

With a Sample Rate of 88.2/96kHz, only Port 1 is enabled. All 32 1/0O channels will be carried through

this Port.
If the Sample Rate is set to 176.4/192kHz, then all 16 I/O channels will be carried through Port 1 as

well.
Port 1 of your IOM-H-PT64 should always be connected to Port 1 on the AVID interface and Port 2

should always be connected to Port 2 even if just one Port is used.

Note: Cables of same length must be used when both ports are connected.
Note: When using 2 IOM-H-PT64 cards in a single device in order to benefit from 64 channels at
88k2/96k, you can connect Port 1 of the first card to HDX/HD Native Port1 and Port 1 of the second

card to HDX/HD Native Port2.

Synchronization and Word Clock

When properly configured, Hapi is able to automatically change its internal clock to match a Pro Tools
project's Sample Rate. The proper IOM-H-PT64 module must be selected in the I/O & Sync menu (PT 1
or PT 2 if module is in Slot 1 or 2). The Auto-follow option must be enabled in Setup -> Format menu,

and Hapi will change its Internal Sample Rate automatically.

48k HM
Internal
Ravenna
WCK

Video{1080sf 23.98)
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In Pro Tools, the Clock source should be set to Internal for the device emulated by the IOM-H-PT64
module (HD MADI in the following example).

Hardware Setup ;gl

Peripherals

HD MADI DigiLink 1 Interface: HD MADT
Physical MADI Format MADI Routing MADI Channel Count
() Optical () Normal (@) Full Channel Count (54)
I N @ Coaxial @) Split () Varispeed Channel Count {58)

HD Core PCIe #1
Sample Rate Conversion

Clock Source:
[ Internal ] v] [T tnput [ output
Loop Master: MADI DigiLink 1 Clock Source Clack Source

SRC Word Clock In 2 |+ SRE Wor 1 =
Sample Rate: » B - )

. Word Clock Base Freguency (44, 1/48) Word Clock Base Frequency (44, 1/48)
z
Input Rate Target Output Rate
44 1kHz [ 48 kHz |+ 44.1kHz / 48 kHz I~
Ext. Clodk Qutput: [Word Clodk (48 kHz) |']

[ 1dentify Set To Default

Sampling Rate mismatch protection

Audio from Pro Tools to Horus and from Horus to Pro Tools is muted when the Sampling Rate asked by
PT is not met by Horus to avoid recording when Sampling Rates mismatch.

Enable the Auto-follow SR option and Synchronize on PT module to avoid any SR mismatch.

Setups with multiple devices

If your setup is made of several Pro Tools Hardware interfaces that need to be synchronized, our
recommendation is to select Internal Clock Source of your IOM-H-PT64 module as the Master Clock.
The other devices present in the setup can be synchronized several different ways.

If two Hapi interfaces are used in a setup, they can be synchronized through the Word Clock
connectors. To send the actual Sample Rate, the Follow SR option in Setup -> Format must be
enabled.

Hapi 1
Pro Tools HD/HDX Sync source :
HD Card 1 |IOM-H-PT64
Clock Source : < > JOMLLRTCS < >
- i
. «
Hapi 1 Internal HD Card 2 WCK Out
Hapi 2 v
WCK In
» 4 >l »
[OMGERTC [ - Sync Source:
WCK

‘AMERG'NG :] www.merging.com/hapi
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The next setup is using Hapi as the Master clock for all devices. In this case, the Clock Source must be
set to the other device’s Word Clock. The Follow SR option in Setup -> Format must be enabled.

Hapi 1
Pro Tools HD/HDX Sync Source:
HD Card 1 _H-
Clock Source : < > IOM-H-PT64 < > P
Other device’s WCIk In HD Card 2 WCK Out

Additionnal HDLink
capable interfaces

In the following setup, an external Master Clock is used for all devices. In this case, the external Master
Clock controls the Hapi Sample Rate. Hence, the external Master Clock must be set accordingly to the
Pro Tools project Sample Rate.

Hapi 1
Pro Tools HD/HDX
HD Card 1 .
| > |OM-H-PT64 < > Sync Source: External Master
Clock Source : WCK Clock
External Master Clock HD Card 2
AWCK In WCK Out
Additionnal HDLink <
capable interfaces
IOM-H-PT64 block diagram

From Pro Tools To Hapi

Decoder » Output Delay
To Pro Tools From Hapi

Encoder < Input Delay

‘AMERG'NG :] www.merging.com/hapi
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Delay compensation

Input and Output delay are strongly dependent on the Hardware. This implies that if one records a
single source with two different devices at the same time, one will get two slightly out-of-phase tracks.
This is explained by the fact that every device has its own circuitry and different components.

To minimize this issue, Pro Tools implemented an Auto Delay Compensation feature which will
automatically shift the recording depending on the Hardware used.

The IOM-H-PT64 module was made to emulate three different Digidesign interfaces and match every
interface’s actual input/output latency (within a margin of maximum 3 samples). This chart shows what
latency to expect for different setups. Analog/Digital modules latencies are already included in these
measures.

Emulation Mode Routing 44k1/48k | 88k2/96k | 176k4/192k
Input - 2* smpl. 2* smpl. 2* smpl.
None

Output - 2* smpl. 2* smpl. 2* smpl.
19210 Input From AD8D 65 smpl. 65 smpl. 65 smpl.
Output To DA8 24 smpl. 14 smpl. 15 smpl.
Input From AD8SD 16 smpl. 12 smpl. 11 smpl.

HDIO = P P P
Output To DA8 56 smpl. 21 smpl. 21 smpl.

Input From MADI 6 I 6 I 7 I

HD MADI pu rom smp smp smp
Output To MADI 5 smpl. 5 smpl. 7 smpl.

* Added to the other modules used

For the delay compensation to be working, it must be enabled in the ProTools software (Options ->
Delay Compensation).

Emulation Mode

Configures which Digidesign interface the IOM-H-PT64 module will emulate in Pro Tools. This option
does not affect the Hapi routing or preamps, it will just set the Input/Output Delays as seen above.
When set to None, Pro Tools will see the module as an HD MADI, but Hapi will use the minimum
latency. Therefore, Delay Compensation will not be accurate on Pro Tools in this mode.

Error AAE -6116

When Hapi is configured to follow the Sample Rate asked by Pro Tools, an AAE -6116 error might
happen when opening a project with a new Sample Rate. If it happens, click OK to close the error
information. Then, when trying to play the file, the error might show again. After clicking OK, the error
should not appear again.

If this issue is too frequent, a way to avoid it is to disable the Auto-Follow option in Setup -> Formats
and change the Sample Rate on Hapi by hand. This should reduce the probability of getting such an
error.
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IOM-HAPI-MADM/MADS
The MADI optional Module card (MADM - Multimode / MADS — Single mode) provides a channel count
of 64 inputs and 64 outputs @1FS

I-l.l.illl

1]
.l

IOM-HAPI-MADM/MADS Features

* MADI Optical and Coaxial inputs and outputs

* 64 discrete channels of digital input and output (extended mode) at 1FS
* Up to 384 kHz sampling rate

* 24-bit resolution

* Fully compliant MADI (AES 10-1991)

* 2 BNC and 1 SC connectors (Multimode or single mode)

Single mode fibers have a lower power loss characteristic than multimode which means that it supports
longer runs but single mode fibers are more expensive. The multimode version (IOM-HAPI-MADM) is the
most widely used optical MADI connection, but for fiber lengths of more than 600m.
Merging Technologies recommends to use the single mode version (IOM-HAPI-MADS).
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HAPI - Cables

Connecting the analog audio Input cables to the AD8/AD8P/AKD8D/AKD8DP/ADA8S/ADASP
modules

The AD/AD8(P) / AKD/AKD8(P) / ADA8(P) modules connect the Mic/Line Inputs using DB25 D-SUB

connections.
Please ensure that the cables you have chosen to use, or have had made, conform to this specification

before you attempt to connect them.

Pin24=(+) | PIn10=(+} | Pin21=(#) | Pin7=(4) | Pin18=(+) | Pin4={) | Pin15=(+) | Pinl=(+}
Part: CON-D25-XLRF Fin12=() | Pin23=() | Pin9=( | Pin20=() | Pin6=( | Pin17=¢) | Pin3=( | Pin14=0Q

Cable Color: black GND Is connected to Pins: 2, 5,8, 11, 16, 19, 22, 25. Pin 13 Is not connected
Numbered XLR fan-out
Cable @: 12 mm

= Cable Length: 1,5m

= Cable Weight: 500 gr

To connect the DSUB connection to the module, align the Male cable connector with the female DSUB
port on the module. Then, with slight pressure, guide the connector into place. If your DSUB connector
has retention screws on either side, then fasten them finger-tight once the connector has been pushed
into place.

Note: The pinout of the DB-25 is as per AES59 (Tascam Analog).

* THESE CONNECTIONS ARE NOT MEANT TO SUPPORT ANY SIGNIFICANT WEIGHT.*
Ensure that there is no strain from the connected cable as any significant pressure on the module’s DSUB
connector could damage the Hapi unit.
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Connecting the analogue outputs cables to the DA8/DASP modules

The IOC-DA8(P) modules connect the line outputs using DB25 D-SUB connections.
Please ensure that the cables you have chosen to use, or have had made, conform to this specification
before you attempt to connect them.
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Specifications out1 out4 outé
Pin24=(+) | Pin10=(#) | Pin21=@) | Pin7={#) | Pin18=(+} | Pind=@) | Pinl15=(4) | Pin1=(+)
= Part: CON-D25-XLRM Pin12=0) | Pin23=0) | Pn9=0) | PIn20=) | Pn6=0) | Pn17=0) | Pn3=p) | Pin14=0)
= Cable Color: black GND s connected to Pins: 2, 5,8, 11, 16, 19, 22, 25. Pin 13 Is not connected
= Numbered XLR fan-out
.

Cable @: 12 mm
= Cable Length: 1,5 m
= Cable Weight: 500 gr

To connect the DSUB connection to the IOC-DA8(P), align the Male cable connector with the female
DSUB port on the module. Then, with slight pressure, guide the connector into place. If your DSUB
connector has mounting screws on either side, then fasten them finger-tight once the connector has
been pushed into place.

Note: The pinout of the DB-25 is as per AES59 (Tascam Analog).

* THESE CONNECTIONS ARE NOT MEANT TO SUPPORT ANY SIGNIFICANT WEIGHT.*
Ensure that there is no strain from the connected cable as any significant pressure on the module’s DSUB
connector could damage the Hapi unit.
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Connecting the AES-EBU cable

The AES ports connect the AES-EBU 1I/O using DB25 D-SUB connections.
Please ensure that the cables you have chosen to use, or have had made, conform to this specification
before you attempt to connect them.
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Specifications AESIN1{1/2) AESIn2(3/4) AESIn3(5/6) AESIn4(7/8) AESOut(1/2) AESOut(3/4) AESOuti5/6) AESOut(7/8)

Pin 24=(+) Pin 10=(+) Fin 21={+) Pin7={+) Fin 18=(+) Pin 4= (+)} Pin 15=(+) Pin1=1(+)
= Part: CON-D25-XLRD Fin12=() | Pin23=() | Pin9={) | Pin20=() | Pin6é=() | Pin17=(J | Pin3=( | Pin1a=()
192 kHz ready GND is connected to Pins: 2, 5, 8, 11, 16, 19, 22, 25. Pin 13 is not connectad

Cable Color: black
Impedance: 110 Ohm
Numbered XLR fan-out
Cable @: 12 mm

= Cable Length: 1,5m

= Cable Weight: 500 gr

To connect the DSUB connection to the AES port, align the Male connector with the female DSUB port
on the module. Then, with slight pressure, guide the connector into place. If your DSUB connector has
mounting screws on either side, then fasten them finger-tightn once the cable has been pushed into
place.

Note #1: The pinout of the DB-25 is as per AES59 (Tascam Digital).

Note #2: Users that have Mykerinos AES or Dual cables cannot use those with their Horus or
Hapi as the pin out is not compatible.

Note #3: DB25 TDIF cables are not compatible with Horus/Hapi AES

* THESE CONNECTIONS ARE NOT MEANT TO SUPPORT ANY SIGNIFICANT WEIGHT.*
Ensure that there is no strain from the connected cable as any significant pressure to the module’s DSUB
connector could damage the Hapi unit.
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Connecting the MADI cable

The MADI port (optional MADI Module) can be connected using either Optical or coaxial cabling.

When using Optical cabling, first ensure that you have a clean work area, as
dust and debris can affect the connection if any obstruction is present.
Remove the cap on both the cable and the port and slowly / firmly push the
cable into the receiving port on the Hapi unit until it clicks into place.
, The MADI optical connector is available in Multimode or Single mode
&4 versions. The Hapi is delivered with Multimode connectors unless specified at
ordering.

For Multimode MADI i/o Merging recommends the use of the OM1 or OM2 Category, with specifications
of 62.5/125 um or 50/125 um. OM3 and OM4 specifications are also supported since those are
improved versions of OM2. The wavelength should be 1300 nm.

When Using a Coaxial connector. Slowly bring the Male cable up to the
female port, ensuring that the pin in the centre of the male cable lines up with
the receptacle in the female port. Push the connector firmly into place and
twist the sleeve clockwise until it clicks into its locked position.

fﬁ.& Maximum recommended cable length is 100 meters

Connecting the Wordclock input/output

The Wordclock connections on the rear of the Hapi unit are coaxial BNC’s. To
connect a Wordclock source from an external device slowly bring the Male
cable up to the female port, ensuring that the pin in the centre of the male
cable lines up with the receptacle in the female port. Push the connector
firmly into place and twist the sleeve clockwise until it clicks into its locked
position.

Connecting the Sync Cable

The Sync Cable (optional with each Hapi unit) is a DB15 cable that connects to the “SYNC” port on the
rear of the Hapi unit. The SYNC cable provides connectivity for LTC and Video Reference Input and
Output for the Hapi unit. To attach this cable to the Hapi unit, align the male connector with the female
DSUB port on the module. Then, with slight pressure, guide the connector into place. Once the cable
has been pushed into place, fasten the mounting screws on either side finger-tight.

Note: The Hapi provides Video Reference I/O Synchronization, but is not a Video reference Generator.

I |
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Sync breakout cable pin-out

Labels : Picture 2 — Connections view of the USB Sync breakout cable
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Connecting the RAVENNA Ethernet cables

The RAVENNA ports (Primary and Secondary) are RJ45 female receptacles.
Simply line up the RJ45 cable with the slot on the rear of the Hapi unit and
slide it into place until it clicks into its locked position.

(Category 5E or 6)

Note: Use the primary (PRI) port. Secondary port behavior depends on the
ST2022-7 mode, set in the Hapi Advanced pages (default mode: network
switch mode). See Network menu — Network operations modes for details.
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HAPI MKII Key Features

Networking

The Merging Hapi MKII fully supports (2) RJ45 connectors, that can be configured in two different
modes, from the RAVENNA Advanced Pages.

1) ST2022-7 mode for network redundancy (Seamless Protection Switching)

2) Network Switch mode, allowing the daisy-chaining of one additional network device without the need
for an external network switch.

Modular analog interfacing

Hapi allows the user to choose between Analog inputs and Analog outputs and MADI 1/O required for
each unit. Hapi provides a total of 2 universal I/O slots which can accept a combination of Mic/Line
modules and or Line output cards and or a MADI module. Configure Hapi with any combination.

For instance, in a studio environment, 8 A/D (1X |OC-AD8/P) and 8 D/A (I0C-AD8/P) will allow for 8
inputs from the live room and 8 outputs to feed studio monitoring and foldback to the artist.

Modular Device connectivity

Any of the modules listed below (A/D, D/A, MADI, AES, ADAT/SPDIF, RAVENNA) can be
interconnected in any way the user chooses. Simple and easy routing pages enable the user to source
signal from any module, and send it to any other combination of modules. An A/D Module could feed 8
Channels of AES Outputs. At the same time, it could feed to 8 MADI channels, or even the RAVENNA
stream as well. This is the function that allows the user operate with the Hapi in either a standalone
(Analog to MADI/AES AD/DA) or in RAVENNA Mode, which connects the audio to a RAVENNA
network (described below).

With such a wealth of different outputs, it made sense to apply a “route to” instead of a “route from”
philosophy in the way Hapi presents its routing pages. After an initial learning period, you will
understand that this is a much more efficient way to present so many routing options in an easy to
unfold process. So always ask yourself first which output is being considered and then decide what
input signal will feed that output and you will be offered all logical and valid choices at every step. It also
made sense to limit the granularity of routing options to blocks of 8 channels, as a good compromise
between flexibility and complexity.

AD8 /| AD8P Remote controlled Mic/Line A/D module

The AD8 (works up to 192 kHz) and the AD8P (works up to DXD/DSD256) are remote controllable,
extremely high-quality Microphone pre-amplifiers with a switch on each channel to route the signal
through dedicated line level circuitry instead. The remote control is achieved over Ethernet, via the
RAVENNA Port at the back of the chassis. With all standard analogue controls also available via
remote (Phantom power on a “per channel’ basis, polarity invert, HPF) and a Gain stage reaching from
-10dB all the way up to +60dB, these modules are not only easy to use, but completely transparent to
listen to as well.

DAS8 / DA8P Safety Conscious Analogue Line output Modules

The DAS8 (works at sample rates up to 192 kHz) and DA8P (works at sample rates up to DSD) are
specifically designed with the user’s speakers in mind. Incorporating analogue mute circuitry, the DA8/P
modules provide protection against spurious transients that may occur during Sample rate changes and
power cycling “clicks” and “pops” which can damage not only speakers, but also the listener’s ears.
When you add to that a noise floor of less than -125dB, these are the ultimate analog outputs for any
monitoring system.

ADA8 Remote controlled Mic/Line A/D module with transparent Analog output

The ADAS8 v1, ADAS8S v2 (work at sample rates up to 192 kHz) and the ADA8P v2 (works at sample
rates up to DSD) are combining high quality Microphone pre-amplifiers and analog output module.

HD Link with Pro Tools HD

The PT Module allows the Horus to communicate with a Pro Tools HD card. With two modules in one
interface, up to 128 channels can be recorded simultaneously.

AVIERGING

:] www.merging.com/hapi
AUDIO FOR THE NETWORKING AGE



HABPI

DC power supply options
Your Hapi interface can be fitted with a DC power supply input, this can be used to battery power the

device or as a secondary power input. The maximum power requirement is 30W thus the supplied
current must be of 2.5A if powered with 12V.

The DC power supply option can be used in two way

1- Battery power: The Hapi can be operated from battery, or any external DC adapter provided the
voltage is between 10V and 14V.

2- Redundant power supply: The Hapi can be operated in a redundant way when using the
standard AC power inlet and an external 12V DC adapter connected to the DC input of Hapi, in
this configuration either power input can fail or be removed without creating any disruption in
the device’s operation.

MADI (Module)

A MADI module is available and can be fitted in one of the Hapi slots. It provides users with up to 64
channels of MADI I/O for use with the system. The signal sent to the MADI Outputs are configurable in
blocks of 8 channels and can be sourced from any other module in the Hapi.

Note: Only one MADI module can be fitted per Hapi, please refer to the MADI module section above.

AES-EBU

1 x D-SUB25 connectors providing 8 channels (4 AES pairs) of AES-EBU I/O are Included as standard.
The AES-EBU signal is transmitted as single wire at all supported sampling rates.

ADAT/SPDIF

8 ADAT 1/O or 2 SPDIF 1/0 (on TOSLINK) are Included as standard. This module is supported up to
4FS (192 kHz)>.

Note: It is recommended to use 3 Meters and less cable length for proper transparency

PT64
64 Channels of Pro Tools HD™ support on Digilink mini connector, from 44.1 to 192 kHz sample rates

Signal routing paradigm

Hapi is quite possibly the most flexible audio interface ever designed. Users can literally route any input
signal to any output module. Better yet, it can route any input signal to any combination of output
modules. Routable in blocks of 8 channels, a user can send 8 Mic Inputs to 8 AES outputs. At the same
time these 8 mic inputs can also be sent via the MADI outputs and included in the RAVENNA stream.

RAVENNA IP Audio

Using RAVENNA |IP audio, Hapi can connect to a standard network, using off the shelf switches and
other IT technology to become a node on a LAN. From that point, any other RAVENNA node can
receive information from and deliver information to, any combination of RAVENNA devices on the
network. It is a revolution in Audio technology and will soon mean the end to costly audio routers and
matrices and allow any facility an immense amount of flexibility. From Broadcast and TV/Film post-
production, to music, live events, theatres, cruise ships and many more applications, the RAVENNA
Enabled Hapi interface will reinvent how systems come together.

The Hapi MKII with its dual network interface provides supports for two different modes of operations.
= ST2022-7 Seamless Protection Switching. For full network redundancy.
= Network Switch mode, allowing the daisy changing of one extra network interface connected
directly to one of the Hapi MKII RJ45 port.

Notice: We do not support multiple daisy chained devices from the Hapi second ethernet port in
switch port. A properly configured Network switch is recommended in order to daisy chain more
than one additional hardware audio interface.

Hapi MKII is NMOS compliant
= NMOS IS-04 (Discovery & Registration)
= NMOS IS-05 (Device Connection Management)

AVIERGING

:] www.merging.com/hapi
AUDIO FOR THE NETWORKING AGE



HABPI

Synchronization
Audio is not the only information that can pass down the RAVENNA connection. Hapi is also able to
send sync (LTC) down the same wire to and from the Hapi unit. For more details refer to the RAVENNA

network guide available on www.merging.com

Key Specifications
Please see the sections below for the measurement performed on the circuitry inside the Hapi unit.
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HAPI MKII - Modules Capabilities

Sampling Rates 44.1/:8kH 88.2/296kH 176.4Iz1 92kH | DXD/384kH DSD64 | DSD128 | DSD256
AD8 - AD8D - AKD8D —
AKDG8D standard N N N
ADS8P - ADSDP -
AKD8DP — AKDG8DP
premium N N N N N
DAS8 standard N J J
DAS8P premium
@ v v v v v
5 ADAS8 N N N
(=]
o] ADAS8S standard N J J
= .
ADAS8P premium N J J J J
PT64 V(6410) | N@3210) | V(161/0)
Headphone N N N N N
MADI V(64 1/0) | N (321/0) (16 1/0) (8 1/0)
AES v v y
ADAT \ (8 1/0) (4 1/0)  (21/0)
SPDIF V(2 1/0) (2 1/0) (2 1/0)
HAPI MKII - Modules Latencies
Sampling Rates 44.1 | 48kHz 88.2 / 96kHz 176.4 | 192kHz DXD / 384kHz
AD standard premium 15 smpl. 10 smpl. 8 smpl. 8 smpl.
AKD standard premium 8 smpl. 8 smpl. 9 smpl. 10 smpl.
AKDG standard premium 9 smpl. 9 smpl. 9 smpl. 9 smpl.
DA standard premium 12 smpl. * 12 smpl. * 12 smpl. * 12 smpl. *
& ADAS
w
5, Input 16 smpl. 16 smpl. 13 smpl. N/A
[=] ADAS8 *x *x o
g Output 9 smpl. 9 smpl. 9 smpl. N/A
ADAB8S/P Input
standard premium 9 smpl. 9 smpl. 9 smpl. 11 smpl.
ADASS/P Output *x *x *x *x
standard premium 9 smpl. 9 smpl. 9 smpl. 9 smpl.
PT64 2 smpl. 2 smpl. 2 smpl. N/A
Headphones 15 smpl. 8 smpl. 8 smpl. 8 smpl.
MADI 3 smpl. 3 smpl. 3 smpl. 3 smpl.
AES 3 smpl. 3 smpl. 3 smpl. N/A

* DA Filter setting
- Slow Roll Off Filter option = 12 Samples
- Sharp Roll Off Filter option = 39 Samples
(More details available under the DA Module chapter below)
** ADA Filter setting
- Slow Roll Off Filter option = 9 Samples

- Sharp Roll Off Filter option = 38 Samples

Note: Internal router of the Hapi MKII may add up to 1 sample of latency
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Installing an additional Hapi I/O Module

Installing additional Hapi I/O Cards (AD8/AD8P/AD8D/AD8DP/ADAS or DA8/DASP)

Before you start

Place the Hapi unit on a hard, dry surface or mount it onto a 19” rack and leave plenty of room
for air convection.

In order to meet the EMC requirements of directives 89/336/EEC and 93/68/EEC, and in order
to obtain the high performance possible for the Hapi unit, you must use correctly shielded
cables of good quality for all external connections when installing the Hapi unit. For the power
connection, a normal unshielded power cable with a proper ground can be used.

Make sure that your sound system is at a safe volume level.

Hardware Installation
This section will take you through installation of your Hapi unit. We will describe how to mount the I/O
modules and the power, audio and digital cable connections that can be accessed on the rear panel.

*PLEASE ENSURE THAT YOUR HAPI UNIT IS SWITCHED OFF BEFORE ATTEMPTING TO

CONNECT ANY CABLES TO THE UNIT.*

If you need to mount an I/O module at a later stage, the following procedure is used.

1.

2.

3.

Place the shutdown Hapi unit on a dry steady horizontal surface. Remove all cables (including
the power cable).

On the back of the Hapi unit there are 2 slots for mounting the Analog 1/O cards or a MADI
card.

To remove blind plates from 1/0O module slots, remove the 2 screws on either side of the plate.
Use a Phillips (cruciform) screwdriver tool size 2

Only remove the number of blind plates necessary to fit the /0O module(s). If only one 1/O slot is
installed, remove only 1 blind plate. If 2 I/O slots are installed, remove 2 blind plates.

It is very important to insert the 1/0 card horizontally and carefully into the Hapi unit. There are
6 set of guides inside the Hapi unit to guide the 1/0 cards correctly into place. Do not use force
in any way to insert the I/O card. This may damage the card. Slide card slowly as picture below
shows.

When the cover plate of the I/O card covers the hole created by removing the blind plate, the 2
screws from the blind plate are mounted in the sides of the I/O card. Tighten the screws
carefully and be careful not to damage the threads.

After inserting the 1/0 module, the Hapi unit might need to be initialized. If this is the case,
please follow the instructions received with the 1/0O module.

AVIERGING :] www.merging.com/hapi

AUDIO FOR THE NETWORKING AGE



HABPI

Installing a Hapi MADI Module (MADM or MADS are optional)
Before you get started

Place the Hapi unit on a hard and dry surface or mount it into a 19” rack and leave plenty of
room for air convection.

- In order to meet the EMC requirements of directives 89/336/EEC and 93/68/EEC, and in order
to obtain the high performance possible for the Hapi unit, you must use correctly shielded
cables of good quality for all external connections when installing the Hapi unit. For the power
connection, a normal unshielded power cable with a proper ground can be used.

- Make sure that your sound system is at a safe volume level

- Only one MADI module card can be fitted per Hapi

Hardware Installation
This section will take you through installation of your Hapi unit. We will describe how to mount the 1/0
modules and the power, audio and digital cable connections that can be accessed on the rear panel.

*PLEASE ENSURE THAT YOUR HAPI UNIT IS SWITCHED OFF BEFORE ATTEMPTING TO
CONNECT ANY CABLES TO THE UNIT.*

Installing Hapi MADI I/O module procedure
The MADI module packaging includes the MADI module along with; two M3 screws, two M2 screws
and a ribbon cable.

g Q 2x M3 screws

. ! 2x M2 screws

1. Place the Hapi unit on a dry steady horizontal surface. Remove all cables (including the power
cable) and unscrew the Hapi top panel.

2. On the Back Panel first slot cover plate

Unscrewed 15t module (Slot 1) cover plate
sSLOoT1

V‘ ‘ e

3. Open the Hapi top panel
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4. Slide the MADI extension board carefully so that the back panel of the module touches the Hapi
back panel.

5. Align the MADI Module over the 2 spacers and screw the MADI module using the 2x M3
screws

6. Connect the ribbon cable from the MADI module to the J7 connector on the Main Hapi board
The connector is on the right on the Ethertube 2 and the closet to the MADI module.

HORUS ~ MADI_EXT Module
ev.

=
B
-
-
-
-
-
-
=
=
=
=
=
=
-
-
=
-
-
-
-
=
-

mmmnm

7. Fix the module to the Hapi rear panel using the two M2 screws
8. Replace any modules that were removed earlier to provide access
9. Close the Hapi top panel cover and replace the fixing screws

10. Power the Hapi back on and the MADI module will be recognized
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Assembling the Rack Mount ears

Hapi is delivered with two rack mount ears for easy installation into a 19” rack.
The ears can be mounted either on the front or the rear of the device.

Installing the rack mount ears on the front panel
1. Turn off and unplug your Hapi
2. Unscrew the eight (8) M3x5 screws located on the side of the device (4 screws per side)
3. Place the rack mount ears on the side of Hapi, as shown in the pictures below

4. Fix the ears with the four (4) M3x8 screws delivered with the ears

Installing the rack mount ears on the rear panel
1. Turn off and unplug your Hapi
2. Place the rack mount ears on the side of Hapi, as shown in the pictures beow

=S \.‘et" i T
3. Fix the ears with the four (4) M3x8 screws delivered with the ears

Hapi recommended placement in Rack

Due to confined space in a rack furniture, adequate spacing (and ordering) between multiple Hapi or
Horus units will play a significant role on the units temperature. Although Merging has spent
considerable time in optimizing the Hapi power consumption in every aspect possible, the units are still
drawing an average of 30W. The dissipation of the related heat produced by this consumption is
therefore highly dependent on the airflow and natural air convection around those units.

With highly loaded Horus units (more than 3 1/O Analog modules per unit) or Hapi units (2 I/O Analog
modules per unit), Merging recommends a free space of 1U above each unit to ensure adequate
cooling of the devices, if no other heating elements are present.
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Installing the Merging NET-MSC-GBEX1

(PCle Ethernet Controller Card for MassCore users only)

Detailed steps on how to install the NET-MSC-GBEX1 PCle card in your PC.

1. Power down your PC and switch it off at the wall. Remove the screws holding the top or side of the
case on and carefully slide off the panel.

ﬁ/ 5

2

‘Al .

2. Wearing an anti-static wristband is desirable whenever working with sensitive electrical equipment.
Keeping one hand on a metal part of the case will have the same effect, though you may need both
hands when installing certain items of hardware.

3. Locate an empty PCle slot and remove the metal backing plate by removing the screw holding it in
place and carefully sliding it up and out. In some cases, there are no backing plates and you will need
to remove a length of metal instead. Do this using a flat-blade screwdriver and/or pliers, taking care to
avoid any sharp edges left behind.

4. Next, remove the NET-MSC-GBEX1 card from its envelope bag and line it up with the vacant PCle
slot as shown below.
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5. Push down gently at first, ensuring you have the pins lined up correctly with the slot, and then apply
more force to slot the card home fully.

6. Use the screw which held the backing plate in place to secure the card and check that the card sits

properly.
Finally, replace the case cover(s) and plug your machine back in.

6. At “First Power Up” Windows will discover the Merging Ethernet PCle card

Note: Refer to the Merging RAVENNA Configuration Guide for more details on the Pyramix MassCore-
RAVENNA setup
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HAPI MK Il - Power ON

Connecting the Power Cable

The Hapi unit runs on 100-240V, 50-60 Hz AC voltage. Excessive voltages can seriously damage the
Hapi unit, so make sure that your AC power matches the voltage of your Hapi unit. When you connect
the power, use the cable you received with your Hapi unit and plug it into a grounded outlet.

For safety and EMC reasons, and to prevent audio hum, the system must be properly grounded. If your
power source does not have a standard three-prong socket, the system must be grounded in another
appropriate manner.

As an option Hapi can also be powered from a DC power source (10-14V), contact your local reseller
about this option.

-l
20-260 VAL /,
S0-80
A
~
DC et
10-149v
254
*

Hapi DC power input

Hapi can be delivered with a DC input capability, when this option is ordered a 4 pins connector
(HR10A-7R-4S) is installed left to the AC power connector. The mating part which is also delivered is a
Hirose HR10-7P-4P.

The pinout of this connector is:

- Pin1:GND
- Pin4:12v

- Pins 2 and 3: not connected
The DC power input accepts voltages from 10V to 14V for a maximum power consumption of 30W.

As an option, Merging does also provide an external AC/DC 30W converter with the appropriate
counter-part connector already mounted. Its product code is PSU-AC/DC-30W.
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AUDIO FOR THE NETWORKING AGE H

www.merging.com/hapi



HABPI

Hapi power up mode selection
The Hapi unit has been designed to have two power up modes selectable with a jumper on the
backplane of Hapi:
- Normal operation: Requires to press on the power button to turn ON Hapi, pressing for more
than 5 seconds on the same button will shut down Hapi
- Always ON operation: As soon as power inlet cable is plugged in the Hapi will power ON,
pressing on the power button to either turn it on of off will have no effect

The selection of the mode can be done using jumper J13 on the backplane of Hapi.

=il X

5 Wwo -

tas |54 :

L4 JN[T=2: usc "AE
7-3: aiwoys O

#48

8L

Jumper J13 pinout:
- 1-2: normal operation
- 2-3: always ON operation

The default ex-factory setting is normal mode

Turn ON your Hapi
1. Press the Hapi Front Panel Power Button

Note: Pressing small triangle will display the Home Page on the Hapi OLED.

Warning: The Hapi Mkll firmware update differs from the Hapi 1generation, since the update can be
performed without a Maintenance mode start up. Refer to the Mkll Firmware update section for details

2. The Hapi front panel button will turn on. If the panel button light isn’t steady but appears to flicker,
this may indicate a fault condition and requires immediate shut down.

3. Wait until the Hapi is fully started and displaying the Main Home screen.

Power Button color code.
Blue: Normal operational state
Yellow: Maintenance mode
Red: Firmware Update State - Do not abort
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HAPI MKII - OLED screen interface
Hapi Menu Hierarchy

D/A Meters

Input Levels

Output Levels

A/D Meters

AD 1
MADI

Loopback

Monitor
Loopback
SPDIF

48kHz  mM

Decay Int. -Tlme: 25 ms/dB
Peak Hold: [On |

MAIN

Volume

TimeCode

Status

Refs
AES - XLR172

100
I

1000

Level:
Mute on Stop:

L1 Status

Pi

[{2ch) |[ PCM |

‘AMERGING

AUDIO FOR THE NETWORKING AGE

AID

DIA

Input Level
QOutput Level
Settings

225 200
M M

Bl s

A 4BV power failure: all A/D 48V
forced of f until next reboot.

Shutdown
Reboot
Reboot to Factory

48kHz =M
Sample Rate:

'WCK Output:
Pull Up/Down:

Load frem:
Save to:

M
ASIO Clock:

Name:
IP Settings:

48kHz WM
Temperature:

Unit serial: Ha5041
ZMAN serial: 524288

Version: 1.0.0b28910
Maintenance: 16

:] www.merging.com/hapi

sjeuLIod

sanpoN

[ ] A1

Mic Alignment:

Serial: AP0
Premium

48kHz =M

Max Level:

Attenuation:

Mute: On |
Roll off Filter: Slow
Serial: DP

Type:  Premium

v/a

WINL

PT 2
Emulation Mode: [HD MADI]
Serial: PT96160 (Run 7)
48kHz WM
Mode:
Physical Mode:
Framing:
48kHz WM Headphone
Attenuation:

Mute:

Time Code

apodauiL

= Level:
Mute on Stop:

Physical Mode:




HABPI

Screen Navigation

The Main Rotary Control gives the user control over the Hapi OLED screen navigation

[l.
_ Rotary Cantrol
Push ---5-- ¢

The Rotary Control: The Rotary Control wheel when turned from right to left navigates
through the available menu, to confirm a Menu entry Push the Rotary
Control button. This will either open a sub-menu or confirm an entered
value.
The Main Rotary Control also gives the user control on the volume level
of the monitoring (Headphone or DA) or the gain level of a selected Mic
PreAmp channel.

Push: Pushing the Rotary button will confirm the menu entry selection or
confirm an entered value.

Long Push: In order to return to the previous screen keep the Rotary Control pushed
for 1 sec. Press hold a few times to return to the Home page.

Home Screen

This is the screen which you will see after the Hapi completes its boot sequence. From here you can
navigate to all the other menus for the setup and use of Hapi. If at any time you want to return to the
Home Screen, you can press and hold the Main Rotary Control button for a second in order to return to
the Home Screen. The screen also has access to the 8 main sections of the Hapi menu: Volume,
Meters, /0, PreAmp, Setup, Presets, Errors and Exit.

Meters
110

PreAmp
Setup
Presets
Errors
Exit

=
Power Up et \
/LJ— Home Page
AN

Pressing only the Home Page small pyramid button will bring the Hapi home page, this is applicable if
no selection is active on the OLED
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Volume Menu
The Volume menu is where the user can determine the analog output module which will be controlled
by the Hapi Rotary Control. It will also display the output meters of the selected module.

48kHz ®EM Volume

-11d8

Headphone

Pressing the Hapi Rotary Control button allows user to select the which analog Module will be volume
controllable

Select:
Mute
Reset Peak

*Headphone

If you have multiple DA and would like to have both of them controlled by the Volume button simply
select the DA1 + DA2 entry

‘Select:
Mute
Reset Peak

D/IA 1+ DIA 2

Meters Menu
The Meters menu is where the user can view the metering of the Hapi available Input or Output

modules.

Input Level

Qutput Level
Settings

A/D Meters Sub-Menu (Meters)
The A/D meters page displays a VU meter for each A/D Input available. If you have 1 x A/D module you
will see 8 VU meters and with 2 x A/D modules you will see 16 VU meters, one for each physical input.

AVIERGING
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D/A Meters Sub-Menu (Meters)

The D/A meters page will display a VU meter for each D/A output available. If you have 1 x D/A module
you will see 8 VU meters, if you have 2 x D/A modules you will see 16 VU meters, so one for each physical
output.

Input Levels Sub-Menu (Meters)

The Input Meters page will display the input metering of the modules present in the Hapi. A metering
view of one Led per input channel is represented in this page.

43k LI Input Level
ADAA1
PT 2

MADI

SPDIF

LED indications: I Peak indication
ClAlignment range
MSignal indicator

12345678

The LEDs indicate the inputs levels of the AD1 inputs 1to 8

Note: You can reset a module Peak by pressing the Rotary Control. In the
example above pressing A/D 1(8ch) will reset the peak displayed on the input 1
This led view ledged also applies to the DA view.

Output Levels Sub-Menu (Meters)

The Output Meters page will display the Output metering of the modules present in the Hapi. A
metering view of one Led per output channel is represented in this page.

43k BN Output Level

ADA1
PT 2

MADI

Headphone
SPDIF

AVIERGING
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Meters Settings Menu
43k ' Sottings

Hot: -0.2 dB
Alignment: -18 dB

Decay Int. Time:
Peak Hold:

Hot : Sets the level above which the meter display will be red. If set to 0dB this will
mean clipping. Range -2dBFS to 0dBFS (PCM)
-2dB to 6dB SACD (DXD/DSD). Reminder: DSD users benefit from a +6dB
headroom in DSD with distortion starting slightly and progressively from
+3.1dB upwards and clipping once reaching +6dB SACD

Alignment: Sets metering level alignment range (yellow leds). Range -24dBFS to 0dB

Decay integration time: Sets the rate at which the level meter display decays after the level falls below
the most recent Peak.

Peak Hold: If ON it will keep the red Peak Hold Overload in display

/0 Menu & Sync Sub-Menu (1/0
48kHz ®M

TimeCode
Status

The 10 and Synchronization menu is where the user can select the source of the Hapi reference clock.
It is essential that these settings are configured correctly in order to ensure a clean audio signal through
the Hapi unit.

Ravenna
WCK

Video{1080sf 23.98)
AES

PT2

MADI

SPDIF

Reference Source Choose the desired sync source by selecting a Reference source.
Available Reference Sources are: RAVENNA, WordClock, MADI, AES or
SPDIF

Reference navigation  Selecting a Reference with multiple choices (such as Sync or AES) will enable
the source navigation. The navigation is performed from top to bottom and will
cycle through in this order at each consecutive press. The selection of another
Reference Source will re-select the top entry in the list by default.

PTP Clock The Precision Time Protocol (PTP) is a protocol used to synchronize
clocks throughout a computer network. Also known as IEEE 1588, it is a
protocol designed to synchronize real-time clocks in the nodes of a distributed
system that communicates using a network. RAVENNA is based on and uses
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HAPI

V2 of this IEEE standardized protocol. PTP Clocks allow for time resolution to

the Nanosecond.

EIll Master: indicates that the current Hapi is the PTP Master

EE] Slave: The Hapi is slave to another PTP Master

The Hapi will always try to be the PTP Master. If multiple Hapi’ or Horus’ are

used in a network environment, the Hapi set in this order will have the PTP

Master priority, using the Best Master Clock Algorithm (BMCA):

1. Video sync

2. Word Clock

3. AES

4. ADAT/SPDIF

5. MADI

6. PT64

7. Internal

8. RAVENNA (always slave unless there is no PTP master available)
Sync Color table: . Dark Blue: Signal present . Red: Unlocked

. Light Blue: Signal valid D Yellow: Locking

Black: No Signal D Green: Locked

Note: When two or more Hapi are connected together through an Ethernet network, one of them will always be
automatically selected as master, the other Hapi' will be forced into slave state and therefore will not be
synchronized to wordclock or audio input. However, this is not a problem since all Hapi' will be synchronized.

Status: LTC IN: Corresponds to the incoming LTC frame rate
Hapi PTP status: MASTER or SLAVE

Video Format Detected:

Supported Formats:

PAL — NTSC

720p23.98— 720p24 — 720p25 — 720p29.97 — 720p30

720p50 — 720p59.94 — 720p60 (not recommended video formats)
1080i25 — 1080i29.97 — 1080i30

1080sf25 — 1080sf29.97 — 1080sf30

1080p23.98 — 1080p24 — 1080p25 — 1080p29.97 — 1080p30

PTP Master note: The GMID (Grand Master ID) is available from Web Access page under 10 & Sync,
and in the Advanced pages — PTP tab.

Refs Sub-Menu (1/0)

This Sub Page menu is where you can view the Deviation and Jitter of the External Reference, as
measured by the Hapi synchronization circuitry.

AVIERGING

:] www.merging.com/hapi
AUDIO FOR THE NETWORKING AGE



HABPI

Frequency:

Delta:

Hafs
AES - XLR1/2

100

-1000 1000

o
L | [oms] | |

The long-term measured Frequency (in Hz) and deviation in ppm (parts per
million) between the signal the unit is locked on to and the internal reference.

The short-term (instantaneous) time offset between the reference signal and
the internal (considered as ideal) reference, measured in nanoseconds (ns).
In other words, the delta indicator over a RAVENNA network will report the
delta in ns between the master and the slave.

Timecode Sub-Menu (1/O)

IN Timecode:
OUT Timecode:

Frame Rate:

From:

Timecode Level:

Mute on Stop:

m Time Coda
04:59:10:10 7097 frmis
04:59:10:10 2997 frm/s

From: Pyramix LTC out

~ Level:
Mute on Stop: On

Will display the current incoming LTC/Timecode
Will display outcoming LTC/Timecode

The current LTC/Timecode Frame Rate is indicated next to the Timecode IN &
OUT display

Indicates the Timecode provider (in example above the Pyramix DAW)

Shows the current LTC output level in dBu. The selector offers a choice of
output level from -18dBu to +9dBu in 3dBu increments, or can be switched off

If OFF the LTC output will not be active (default)
If ON the LTC output is generated constantly

Status Sub-Menu (1/O)

Lists the status of each Module
Channel count (I/0O) and each module Mode (Example: PCM or DSD modes)
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4k mh Status
AES
AD 1
DIA2

MADI
Monitor [ {Zch) |[ PCM_|
Loopback
SPDIF [ {Zch) |[ PCM |
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PreAmp Menu

The PREAMP (A/D) menu becomes active if you have 1 or more AD8(P) modules installed in the Hapi
unit, giving full access to the Input controls. Please see below for a description of the buttons available.

All

Gain slider

Mic (M) or Line (L)

13 14 15 16

0.0 0.0 0.0 0.0
L M M L
43

Fl-
(5]
Hz

43
Bl | | Zhi
F|-

5]

Active: Will select all 8 input channels for function and level grouping
Inactive: Adjustments to the input settings and level affect only the selected
channel only

Note the All button will group all inputs of the same type (Mic or Line)

The Rotary Control will give the user control over the Gain level with
increments/decrements in 0.5 dB steps
The Gain range goes from 0 dB to +66.0 dB from left to right

In Mic mode (M): Sets the Mic Preamplifier's Gain

In Line mode (L): Sets the Line Input Sensitivity

A value of 0dB corresponds to an input sensitivity of +24dBu for 0dBFS. This
corresponds to a calibration level of +4dBu for -20dBFS.

A value of +20.0 dB corresponds to an input sensitivity of +4dBu for 0dBFS

A value of +66.0 dB corresponds to an input sensitivity of -42.0dBu for 0dBFS

Example: Assuming you want to interconnect to an analog console and your
standard studio alignment level is +4dBu for -18dBFS. In this case set the gain
slider to +2dB. Similarly, on the DA analog output side, set the attenuation to -
2dB, refer to section Line Output Level calibration on page 22, provided the
max output level is set to +24dBu.

Switches the Input from the Mic-Pre amplifier to the Line level circuitry. The
button will show the current input signal path it is set for (Mic or Line).

The Line input sensitivity can be adjusted by setting the line gain for each input
of the AD module.

Line Fader of 0 dB, means 0 dBFS for +24 dBu Analog signal level present at
the Line input

Line Fader of + 6 dB, means 0 dBFS for +18 dBu Analog signal level present at
the Line input

Line Fader of + 20 dB, means 0 dBFS for +4 dBu Analog signal level present at
the Line input

Line Fader of + 66 dB, means 0 dBFS for -42 dBu Analog signal level present
at the Line input

Note #1: the MIC and Line inputs are stored as independent parameters,
meaning that switching from Mic to Line and vice versa will load its own gain
(sensitivity) value

Note #2: The Premium AD converters have been designed in order to be able
to benefit from the +3.1 dB SA-CD headroom offered by DSD, as per the
scarlet book standard. The gain range goes from +0dB to +66dB in both PCM
and DSD mode. In DSD mode it is possible to set a gain of up to +6dB on a
full-scale signal to benefit from the SACD headroom.
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48V

Zlo — Zhi

PAD (P - B)

%]

80 Hz (Hz)
Meters dB scaling

Meters color range

Rst

Navigation

This button will turn on 48V phantom power for the channel. If it is lit, it means
that Phantom power is active. Only active on channels set to Mic.

The total current drawn on the phantom power by all the microphones should
never exceed 48mA for the whole device

If a MAJOR (by MAJOR, we mean that the threshold of short-circuit detection
requires at least 10 Preamp inputs to be shorted simultaneously) 48V Phantom
Power Supply short circuit is detected, 48V is forced off on all A/D channels
and the following error message is displayed.

“48V power failure: all A/D 48V forced off until next reboot”

This warning applies ONLY to the initial RUN 3 production batch of AD8 and AD8P and has been
fixed for all modules shipped starting November 2012:

The 48V power MUST be turned off prior to changing the connection in certain patch bays. Many
such patch bays do short the Hot, Cold or both signals to Ground during insertion or removal of the
Jacks with the risk of deteriorating permanently the protective resistors in the input of the PreAmp
circuitry. If an AD module input circuitry is damaged, following such a short, it will end up
permanently having inaccurate gain levels, distortion or even no signal at all on some channels.
That would require hardware replacements at your own cost, since such damage is not covered by
our warranty.

If you still own one of the original and unmodified RUN 3 AD8/AD8SP modules we recommend that
you contact your Merging reseller to organize an update of your module(s), which Merging is
pleased to provide free of charge.

Mic input impedance (only available for ADA8, AD8D/ADS8DP run 9 and above)
and AKD8D/AKD8DP modules.

For the different mic input impedance values, please refer to the card
specifications.

A -10 dB Pad can be applied in the Mic Preamp circuitry.

B- Boost: Increases the mic input signal level by 12 dB > Max input level 0dBu
Note: The Boost is only available for the modules ADA8S and ADA8SP
Recommended for Ribbon Microphones that have low output.

Polarity invert button. When lit, it inverts the polarity of the selected input
signal.

Low cut filter 80 Hz. Second order, 12 dB/octave.
The Meters scaling is displaying from -90 dBFS to 0 dBFS.

Refer to the Meters Page Settings, in order to adjust the Level meter color
range (Peak, Alignment and Decay time).

Stands for Reset Peaks Hold Meters. The top Red led of the PreAmp metering
will indicate that a Peak has occurred. In order to clear the Peak display, simply
press the RST button on the remote web access. To reset the peaks on the
OLED you must refresh the PreAmps Page by going to previous one and back.
Enabled the Peak Hold option under the Meters menu Settings

Use the left << and right >> arrows in order to navigate through the banks of 8
inputs. Will be active if more than one AD8(P) module is present in the unit.
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Setup Menu

The Setup menu’s primary page contains function buttons described below as well as sub-menu links
listed in the sub-sections; Formats, Routing, Modules, Presets, System, Network and Info

Formats
Routing
Modules
Presets
System
Network
Infa

Formats Menu (Setup)

48kHz L1

Sample Rate:

WCK OQutput:
Pull Up/Down:

Sample Rate: Select the Hapi Sampling Rate
441 kHz - 48 kHz - 88.2 kHz - 176.4 kHz - 192 kHz - 384 kHz — DXD/DSD
Note: The available Sampling Rates depend on the Hapi Analog module cards.
Only Premium Analog modules offer support beyond 192 kHz.

Auto Auto Sampling Rate mode. Hapi will automatically follow the sampling rate
given by a RAVENNA source provided by; ASIO / Virtual Audio Device
(Formerly Core Audio Driver), MassCore or another Horus/Hapi) or external
Input Sync source.

Example 1: User using an external player (such as jRiver) can enable the Auto
mode so that Hapi automatically changes its sampling rate according to the
media file being played back.

Provided at least one RAVENNA ASIO or Virtual Audio Device (formerly Core
Audio) stream is connected to an Output of the Horus/Hapi

Example 2: This Auto setting can apply to user running the RAVENNA ASIO or
Virtual Audio Device (formerly Core Audio) so that Hapi adapts its sampling
rate automatically.

Provided at least one RAVENNA ASIO or Virtual Audio Device (formerly Core
Audio) stream is connected to an Output of the Horus/Hapi

Example 3: Another usage of this « Auto » sample rate button is to enable the
Horus/Hapi locked (e.g. WordClock) to automatically follow the sample rate of
the WordClock generator (same applies to AES/MADI/ADAT sync).

Provided at least one RAVENNA ASIO or Virtual Audio Device (formerly Core
Audio) stream is connected to an Output of the Horus/Hapi
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A/D Mode in DXD/DSD:

WordClock Output:

Pull Up/Down:

Warning: The Auto sampling Rate option must be disabled if locking the
Horus/Hapi devices to reference (e.g. 44.1kHz WordClock) which would be
different than the working Sampling Rate Format (E.g. 88.2kHz,,192kHz, DXD.)
For MADI, the Auto sampling rate option depends on the MADI framing (48 or
96k frame). Therefore it is recommended to disable the option at sampling
rates higher than 48 kHz.

Note: If using ANEMAN with a Sampling Rate Zone the device on the Crown
will decide the Master sampling rate of all the devices present in the Zone.

In such a case it is recommended to disable the Hapi Mkll Auto Sampling Rate
mode to avoid fights over the sampling rate of the non-Crowned devices at a
given moment, since those could potentially cause sampling rate flickering.

This format setup only applies to the AD module which can be set to either
DXD - DSD64 - DSD128 - DSD256

Note: The Hapi can be configured in DXD/DSD and in this mode the Hapi can
receive any audio data format stream and can generate DXD or DSD(64, 128
or 256) stream depending on the A/D audio data format chosen.

44k1 / 48k: When enabled the Wordclock Output will be at either 44.1kHz or
48kHz

Example:

Sampling Rate: 44k1/88k2/176k4 the WordClock Output will be 44.1kHz
Sampling Rate: 44k/96k/192k the WordClock Output will be 48kHz.

Follow SR: When enabled the WordClock Ouput will follow the Sampling Rate
selected.

Example:

If the selected Sampling Rate is 48k the WordClock output will be at 48kHz

If the selected Sampling Rate is 176k4 the WordClock output will be 176.4kHz

Slow down or accelerate audio clock by 0.1 % depending of the frame rate of
the video reference.

This option will only be active if the sync source is configured to Video Ref.

The Status of this option can be viewed in the IO&Sync page under Status

- Off: Normal operating mode

- Up: Accelerate the clock by 0.1%. Supported only with a Video reference at
24fps and 30fps

- Down: Slowdown the clock by 0.1%. Supported only with a Video reference at
23.98fps and 29.97fps
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Routing Menu (Setup)

Module routing menu describes where the signal for each module in the Hapi is coming from. Each
button leads to a sub-menu that allows the user to change the source of the signal to that specific
module. For instance, the Headphone in the Routing menu will allow the user to change the routing of
the Headphone.

Choices are made in blocks of 8 channels from the OLED (except for the Monitor, which is a Stereo
signal). As of the Hapi MKII single channel routing is supported but has to be performed via the
RAVENNA Advanced pages. For more information refer to the Advanced Pages online guide.
https://merging.atlassian.net/wiki/spaces/PUBLICDOC/pages/4819571/Merging+RAVENNA+Advanced
+Pages+User+Guide.

Note: The Hapi MKII is different from its predecessor Hapi and Horus since it is based on a routing
architecture, each routing performed remains exclusive but without automatic stream connectivity.

So, following an internal routing if the operator decides to revert to its preceding RAVENNA routing this
one will have to be reconnected in ANEMAN to stream back audio.

48kHz M Routing
AES
Headphone
DAS8 1 | ADS {1 |

MADI 1 1-8
MADI 1 9-16
MADI 1 17-2
MADI 1 25-3
MADI 1 33-4

Here the AD8 module is routed to the DA8 module and it will remain available for RAVENNA routing

ADAT: Takes you to the ADAT Routing configuration page (refer below)
AES: Takes you to the AES Routing configuration page (refer below)

D/A: Takes you to the D/A Routing configuration page (refer below)

PT64: Takes you to the PT64 Routing configuration page (refer below)
MADI: Takes you to the MADI Routing configuration page (refer below)
HEADPHONE: Takes you to the Headphone Routing configuration page (refer below)
SPDIF: Takes you to the SPDIF Routing configuration page (refer below)
A/D: Disabled as one cannot route TO an Input!

Loopback: Takes you to the Loopback module (present only in debug mode)

Warning: Two inputs can’t be routed to the same output, as we are routing channels and not mixing.

Routing: Source Configuration

ADAT - AES - D/A - MADI - SPDIF Routing Output Source (similar)

| *None

AD8 1

MADI 1 1-8
MADI 1 9-16
MADI 1 17-24
MADI 1 25-

For all of the output modules (ADAT/SPDIF,AES, D/A N, PT64, MADI & Headphone Jack) the user can
set where the signal feeding it comes from. Any combination is possible using the Output source page
linked to any of the output modules.

* All routing in the Hapi is currently achieved using banks of 8 channels.

AVIERGING

:] www.merging.com/hapi
AUDIO FOR THE NETWORKING AGE


https://merging.atlassian.net/wiki/spaces/PUBLICDOC/pages/4819571/Merging+RAVENNA+Advanced+Pages+User+Guide
https://merging.atlassian.net/wiki/spaces/PUBLICDOC/pages/4819571/Merging+RAVENNA+Advanced+Pages+User+Guide

HAPI

Unrouted: No internal routing has been performed, the module remains available for
RAVENNA and/or internal routing

ADAT/SPDIF: Sets the module being configured to receive signal from the ADAT/SPDIF

AES: Sets the module being configured to receive signal from a bank of AES-EBU
inputs.

MADI: Enables the module being configured to receive signal from any 8-channel
bank in either of the MADI streams

PT N: Enables the module being configured to receive signal from any 8-channel
bank in either of the PT64 modules.

A/D N: Sends the signal coming in from the Mic or Line input modules to the output
module being configured

Loopback: Should only be used for test purposes.

Routing Example:
MADI Routing Output: Users can route literally any input signal to any output module. Users can also
route any input signal to any combination of output modules. Signals are
routable in blocks of 8 channels.

The example picture below shows the MADI output1-8 routing being selected
from the Routing page on the ADA8 module channels 1-8

192kHz M Routing

AES
Headphone
ADA8V2 1

With Hapi MKII single channel routing is supported but has to be performed via the RAVENNA

ADAS8V2 1

MADI 1 1-8
MADI 1 9-16_Unrouted |
MADI 2 1-8
MADI 2 9-1€
SPDIF

MADI 1 1-8
MADI 1 9-16[_Unrouted |
MADI 2 1-8

MADI 2 9-16
SPDIF __Unrouted

Advanced pages. For more information refer to the Advanced Pages online guide.

https://merging.atlassian.net/wiki/spaces/PUBLICDOC/pages/4819571/Merging+RAVENNA+Advanced

+Pages+User+Guide.
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Modules Menu (Setup)

48kHz M Modules
AES

Headphone

Trim: Headphone

DAS 1

Trim: DAS8 1
ADS8 1
MADI 1
SPDIF

Selecting one of the Modules described below will open the Module 1/O configuration menu

AES
Included as standard. The AES buttons are active since this module is included as standard.
Connectivity is over 1 D-SUB25 connectors providing 8 channels (4 AES pairs) of AES-EBU |/O.

Headphone
Shortcut to the Headphone monitor page described above.

D/AN
The D/A buttons become active when 1 or more IOC-DA8(P) modules are installed in the Hapi unit.

Trim : Headphone / DA N/ ADA N
Hapi MKII provides single channel trim support.

A/DN/AKDN

The A/D buttons, which become active if you have 1 or more AD8(P) modules installed in the Hapi unit,
give access to the Input controls. N being a number incrementing from 1 to 2. Please see below for a
description of the buttons available.

ADA N
The ADA buttons, which become active if you have 1 or more ADA8 or ADAv2 modules installed in the
Hapi unit, give access to the Input controls.

PTN
The PT buttons become active when an IOC-H-PT64 module is installed.

MADI
MADI module is optional with each Hapi. Only one MADI module can be fitted per Hapi.

TimeCode
Included as standard. The TimeCode button is active since this module is included as standard and will
bring you to the TimeCode page.

ADAT/SPDIF
ADAT/SPDIF module is included as standard with each Hapi.
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HAPI
Headphone Menu

The Headphone menu refers to the Hapi front panel Headphone Monitor jacks. The Headphone jacks 1
& 2 (6.3 mm and 3.5 mm) output the same source and level.

Attenuation:

Mute:

Attenuation: Sets the attenuation of the Headphone output. By selecting (Rotary Push) the
Attenuation entry and using the Hapi Rotary Control (Left= less gain / Right=
more attenuation) to set the attenuation to the desired level
Headphone level range: -60 dB to +12 dB with 0.1dB precision.

Headphone Mute: Mutes the headphone output when ON is enabled

Roll off Filter: Slow (default): Offers the lowest latency of 9 samples, with the tradeoff of a
gentle frequency response attenuation reaching -3dB at 0.45 x FS (21.6 kHz

@48k)

Sharp: Offers a flat frequency response with an attenuation of 3 dB at 0.484 x
FS (23.2 kHz @48k), which has the tradeoff of 35 samples latency.

Apodizing: Fast Roll-Off filter, Linear phase filter. Latency of 35 samples

Brickwall: Ensures rejection of more than -100dB at Nyquist (0.50 x FS, 24
kHz @48k). Latency of 35 samples

} Select:
*Slow

Apodizing
H Brickwall

TRIM: Headphones

Left [0dB]
Right 0dB

Open the Trim Headphone page in order to have trim level per channel support. The headphone
module offers 2 channel trims (left and Right) on a .1 dB step scale. With a per channel polarity
parameter and a two channels one.
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Modules: MADI Sub-Menu

MADI module is optional with each Hapi.

Mode:

Physical Mode:

Output Mirror

Legacy/High Speed:

48kHz EM

Mode:
Physical Mode:

Output Mirror:
Framing:

Sets the MADI mode to either “Standard” (56 audio channels) or “Extended”
(64 channels). To determine which setting(s) you are able to use, please
consult the user manual of the device you are connecting the Hapi to in order
to see which (if not both) formats it complies with.

Note: MADI Standard (56) can only be enabled at 1FS (44.1kHz/48kHz) above
1FS we will automatically revert to MADI Extended (64).

Choose the input signal to be derived from the Coaxial or Optical MADI
connections at the back of the Hapi unit. You can choose to use either or, but
not both at the same time

Choose if the output MIDI signal goes out from the Coaxial and Optical MADI
at the same time, thus is mirrored. Available as of firmware 1.5.7 and above.

Choose between using Legacy (48k Frame) or High-speed (96K to 192K
Frame).

This option is only available for MADI output at 88.2/96kHz sampling rate
and176.4/192kHz sampling rate and is dependent of the device used in
conjunction with the Hapi

Note: Mykerinos users who are connected to the Hapi should configure their
Mykerinos Pyramix general settings so that the MADI High Speed mode is
disabled and then set the Hapi to 48k Frame (legacy).

Modules: A/D Sub-Menu

Mic Alignment:

Serial Number:

48kHz EM AD8 1

Mic Alignment: [0.0 dB]

Serial: AP83424 (Run 7)
Type: Premium

User can offset the Mic Gain Alignment scaling from a Range of 0dB to +12dB.

Example: Setting a gain alignment of +10dB will make the Hapi, Web Access
or the Pyramix PreAmps control to be offset by a scaling of +10 dB.

This is the place you can access all your Modules serial numbers without
having to unslot them or open the box
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Type:

Module Type description (Example : Premium Direct Out)

Modules: ADA Sub-Menu

Mic Alignment:

Max Level

Output attenuation:

Roll Off Filter:

Serial Number:

Type:

48k L1 ADA 2

Mic Alignment:

Max Level: +24 dBu

Attenuation:
Roll off Filter:
Seriak AAP103326
Type: Standard

User can offset the Mic Gain Alignment scaling from a Range of 0dB to +12dB.

Example: Setting a gain alignment of +10dB will make the Hapi, Web Access
or the Pyramix PreAmps control to be offset by a scaling of +10 dB.

Maximum Output Level: +18 dBu or +24 dBu

Calibration of the D/A output (Range -60.0 dB to 0 dB with 0.1 dB precision).
Refer to the Hardware section for the D/A onboard output level calibration.

Recent ADA8S/P modules offers 4 roll off filters: Slow, Sharp, Apodizing and
Brickwall. Refer to the ADA8S/P Module section at page 31 for more details

Previous ADA module offer 2 Roll Off filters. Sharp or Slow.

Sharp roll-off filter: Offers a flat frequency response up to 22kHz, within 0.2dB,
which has the tradeoff of 36 samples latency.

Slow roll-off filter: Offers a low latency of 9 samples, with the tradeoff of a
gentle frequency response attenuation starting around 16kHz and reaching -
2.5dB at 22kHz. This mode is the default one.

This is the place you can access all your Modules serial numbers without
having to unslot them or open the box

Module Type description

Modules: D/A Sub-Menu

Max Level:

48kHz M DA8 1

Max Level: 18 dB

Attenuation:

Mute:

Roll off Filter:

Serial: DP103045 (Run 7)
Type: Premium

On the DA8 and DAS8P cards, the output level setting for all channels is done
via software through the option “max output level” in each DA’s setting page,
allowing either + 24 dBu or 18 dBu max level.
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Output attenuation:

Mute:

Roll Off Filter:

Serial Number:

Type:

TRIM: DA

For a more precise trimming of the output level, the output attenuation can be
set on the same page

Calibration of the D/A output. Range -60.0 dB to 0 dB with 0.1 dB precision
steps
Refer to the Hardware section for the D/A onboard output level calibration.

Mutes all the DA output channels when ON is enabled

Sharp roll-off filter: Offers a flat frequency response up to 22kHz, within 0.2dB,
which has the tradeoff of 36 samples latency. This mode was and still is the
default one.

Slow roll-off filter (default): Offers a low latency of 9 samples, with the tradeoff
of a gentle frequency response attenuation starting around 16kHz and reaching
-2.5dB at 22kHz

Module serial numbers

Module Type description

Open the Trim DA page in order to have trim level per channel support. The DA module offers 8
channel trims, from channel 1 to channel 8 on a .1 dB step scale. With a per channel polarity

parameter.

Modules: PT64 Sub-Menu

48

Emulation Mode:

Serial: PT96160 (Run 7)

Emulation mode:

Serial Number:

Output Source:

k L PT 2 Select:
Mone

192 11O
HD 1/O

*HD MADI

Selection of the Hardware emulated in Pro Tools. Latency is adapted to the
mode chosen, see detailed table in IOM-H-PT64 section.
None mode is seen as an HD MADI in Pro Tools, but has the lowest latency.

Module Serial Number and Run
Selection of the output source sent to Pro Tools for each of the 8 groups. Any

of the digital or analog inputs can be routed to Pro Tools as well as RAVENNA
signals.
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Modules: Loopback (hidden menu, available only for debug use)

Transparency Check:

Word Length:

Status:

Latency:

This is a Debug Utility tool that verifies the bit transparency of the audio path
On: Transparency check enabled
Off: Loopback mode enabled

Word length of the digital audio data signal (16 bits or 24 bits)
Green: Path transparency valid
Black: Path is not transparent

Numbering: indicates the number of discontinuities measured

Output to Input delay in samples

Presets Menu (Setup)

Load:

Save:

Auto Save:

43k LI Progols

Load from:
Save to:

Auto Save:

5 presets banks of different Hapi configurations can be loaded (one at a time)
5 presets banks are available to store different Hapi configurations
If enabled the save configuration will happen at every 2 minutes.

Note: Since the flash memory which is at the heart of the Hapi storage has a
huge (but not infinite) amount of write cycles, we limit the auto-save of all
configuration and PreAmps settings to once every two minutes if (and only if) a
change has occurred meanwhile.

Furthermore, both Shutdown and Reboot buttons (in Setup page) do also
entirely save the current configuration of the Hapi prior to power down.
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System (Setup):

ASIO Clock:

Home Page:

Latency:

Terminations:

Brightness:

48kHz M System

ASIO Clock:

Home page: 15s
Volume

Latency: Low (64)
WCK term.: 75Q
Video term.: 75Q
Brightness: 7

If set to Auto enabled: The ASIO clock will be generated by the Hapi which will
be PTP Master.

If Auto is disabled: The ASIO clock will always be generated by this Hapi.
Note: Do not disable unless you are sure that no Hapi will be PTP Master.

Users can decide what will be their Hapi OLED Home Page. You can return to
the Home Page by performing consecutive 1 sec push hold or by pressing and
releasing the Hapi front panel Home Page button (small Pyramid). Users can
also set a Home page display delay option of; 15 seconds, 30 seconds, 1
minute or set it to Never (disabled).

A/D Metering: The screensaver redirects you to the AD Meters Page.
D/A Metering: The screensaver redirects you to the DA Meters Page.
In Levels: The screensaver redirects you to the Input Level Page.
Out Levels: The screensaver redirects you to the Output Level Page.
Volume: The screensaver redirects you to the Volume Page.

Long push the Rotary Control to exit those pages.

Screensaver: The Hapi screen will turn black after a 1Tmin delay wihout user
interaction. This is in order to preserve the life span of the Hapi OLED display.
To exit the Screensaver press the Rotary Control Button.

The Hapi has 4 Latency Settings (in samples) that will determine the device
latency over a RAVENNA network. When multiple RAVENNA devices (e.g.
Horus & Hapi) are connected over a network, they adjust themselves to the
lowest latency that can globally be achieved.

- Ultra Low (16 smp)

- Extra Low (32 smp)

- AES 67 (48 smp)

- Low (64 smp)

75Q for WCK: Sets 75Q termination for the Wordclock Input.

750 for Video: Sets 75Q termination for the Video reference Input. Unless the
Video Reference signal provided to the Hapi is daisy-chained to other
equipment, you should always terminate your Video signal for most reliable
operation.

Users can set the Hapi Power Button and OLED display luminosity.
This may save some power and hence some internally generated heat.

Note: during the adjustments the OLED will flicker black and update the
brightness value.
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Network Menu (Setup)

06k mH Network
Hame: Hapi

IP Settings:

Device Name: Name of the Hapi unit. This name will be broadcast across the network and will
be seen in applications such as the MT Discovery tool or ANEMAN. The Hapi
unit name can be changed from the Web control access Network page (see
section below for all details)

IP Settings: Manual: Type IP address using box selection and the - or + buttons
Auto: The IP address will be automatically attributed using ZeroConf/Auto-IP
mechanism (address range 169.254.xx.xx if no DHCP server is present)

Address: Set the IP Address for the Hapi unit by using box selection and the - or +
buttons (Available only with IP Settings = Manual)

Netmask: Set the Subnet Mask for the Hapi unit by using box selection and the < or >
buttons (Available only with IP Settings = Manual)

Apply & Reboot: Once changes have been made to this section, you must press this button to
save the settings and power cycle the Hapi unit

Note:

Hapi has no DHCP-server capability neither does the Merging PCle Ethernet
Controller Card NET-MSC-GBEX1.

By default the Hapi IP setting is set to “Auto” configuration mode which gives
an address in the range 169.254.xxx.xxx if no DHCP server is present on the
network. Users are free to put a DHCP server in their RAVENNA network with
a customized address range and the Hapi would get an IP address from this
server. Note that our recommended RAVENNA switches are configured with
DHCRP disabled.

Merging recommend the Hapi to be configured in “Auto” mode and the Merging
PCle Ethernet Controller Card NET-MSC-GBEXT1 to also be configured with
“Internet Protocol Version 4” with “Obtain an IP automatically”.

HAPI MKII NETWORK OPERATION MODES
The Hapi MKII RAVENNA provides two network operation modes.

1- ST2022-7 Seamless Protection Switching

2- Network Switch mode (default). Allowing daisy chain for an extra network device

Those modes of operation are available for selection from the RAVENNA Advanced Pages.

Find more details here.
https://merging.atlassian.net/wiki/spaces/PUBLICDOC/pages/4819571/Merging+RAVENNA+Advanced
+Pages+User+Guide.
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HABPI

C ¢+ A Notsecure | 169.254.250.111/advanced/indexhtm * 6
J— Vendor Merging Technologies
== RAVENNA P
roduct HAPI_Mkll
Serial H95003 ManeERcING

& HapiMkil_95003.local. ~ @
General settings PTP  Session sources  Session sinks  Ins/Outs /O Router  Statistics NMOS  System

Device Name

HapiMkIl_95003
This is the unique zeroconf device name. Other devices see this device name.

Audio Configuration

Sample rate 3528 kHz ~
Frame size (@ 1FS) 64 smpl x

Session Sinks Global

Safety Playout Delay (@1FS) 0
SSM (requires IGMP v3)

Network

ST2022-7 mode <:| When disabled the HAPI MKII operates in Network Switch mode

Interface 1

Link

Name eth0

Type Zeroconf ~

Address 169.2564.250

Netmask 55.255 0.0

Gateway 0.0.0.0 + Use as Primary Gateway
Apply

Note: chanaina the nelwork sellinas reauire a rebool of the device,

Info (Setup):

In this sub menu you will find details about the Hapi internals; temperature, serial number and the
firmware version currently installed.

48kHz M Info

Temperature: 47 [°C]

Unit serial: H95041
ZMAN serial: 10289152

Version: 1.0.0b28910
Maintenance: 16

ERROR Menu

List the errors detected by the Hapi. Refer to the troubleshooting section below for details of each
errors. The Clear entry will delete the listed errors.
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48k EM E Errors
Etharnet input: Wrong sequence
mnnnbser
4BV power failure: all AD 48V
forced of f wntil next reboot.
EXIT Menu
48kHz [\ Exit
Reboot
Reboot to Factory
Shutdown: Initiates a proper shutdown of the Hapi unit, including a save of the current
configuration. Do not attempt to shutdown the Hapi unit in other ways (such as
using the power switch on the back of the device).
Reboot: Power cycles the Hapi unit (shutdown>Boot up)
Reboot to Factory: If selected we will reboot the Hapi to the default factory configuration. The
Current configuration will be lost but all the saved presets will be kept and can
be reloaded.
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HAPI MKII - Web Control Access

Installing and accessing the Hapi Control interface remotely

To control and view your Hapi remotely with a web browser make sure that you are using one of the
Internet browsers below: Google Chrome (Highly Recommended), Mozilla Firefox, Opera, Apple
Safari, Microsoft Edge. * Microsoft Internet Explorer is not supported *

Then take the following steps:

1) If you did not install Pyramix or Ovation proceed from step 2 to 3. If you have already installed a
Pyramix / Ovation go directly to step 4)

2) Download either ANEMAN or the MTDiscovery.exe application to your system (PC or MAC
installers are available)
https://www.merging.com/products/interfaces/downloads

3) Make sure your Hapi is connected to the same network as your system, and is configured with
the correct IP settings (See “Setting up the Hapi IP Address”)

4) Launch the MT Discovery tool (MTDiscovery.exe) or ANEMAN (Aneman.exe)

Any Hapi devices on the network will be discovered by the MT Discovery tool or ANEMAN and will
appear under the “RAVENNA Devices”
- A mouse double-click on the Hapi Device entry will open the Hapi Web Interface in your default
web browser
- Only Devices on the same network (same color in display) can have their I/O interconnected
- *Microsoft Internet Explorer is not recommended for this*

MT Discovery Window ANEMAN
r MT Discovery =RACE X |

MT Discover'y

Technolagies Inc. - all Fights resered, AMERGING ANEMAN

7 Bonjour Network D | |Adion View Settings Debug Help

= Favorites Rearrange Zoom Al Auto Zoom New Logic Zone Mew Sample Rate Zor|
B[ 4 Ravenna Devices "

| @ Horus Devices
= MassCore Devices
" [@)MassCore Device (on Caribou?) (12693550)
| @Asio/CoreAudio Devices @
E-| 4 Other Ravenna Devices
= Hapi Device (on Hapi_90064) (90064) -
Emotion Servers 9%3';3

@Pyramix Servers

[ VCube MXFix Servers

@ Ovation Servers
Others

[T}

Using the Webpage, you can browse the Menus and change parameters in exactly the same manner
as on the front panel TFT of the Hapi unit in question.

Warning: It is mandatory that you connect the Hapi to a Gigabit Ethernet Port or Switch for remote
access.
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HAPI MKIl Web Access

IMIT=I==E]INIE EE = ATET rvrr

- . g 4 ] by
LY

The Web access Hapi MKIlI menu pages are based on the Horus layout and differ from the Hapi MKII
OLED screen. For precise description of each parameter refer to the Hapi MKII OLED description of the
parameter as the Web Access is remote controlling the same parameters that are available on the Hap
MKII OLED display.

Home Page Web Access

The Hapi remote Home page is the default web access page displayed at opening and is different form
the Hapi OLED home page display.

kil

“ HEADPHONE METERS I/O & SYNC PREAMP SETUP

HOME PAGE LAYOUT ENTRIES

HEADPHONE
Direct access to the Headphones pages

Gain: 0.0dB

Output Source:

‘. i Headphone
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METERS
The Meters web menu will display the input and output metering of the modules present in the Hapi.

At the top of the Meters Web Access page is the Stream Metering section which provides metering of
your RAVENNA/AES67 AolP streams, this section is divided in two.

Receivers (Channel 1 to 256)

Senders (Channel 1 to 256)

Note: this section is useful to identify if audio is being streamed, if you see metering and cannot monitor
your signal, the problem is mostly probably a routing one.

2 2 W W M % W M 2 M 6 4B W W M % M K0 &2 64 6

T T EE R T T S T

et

). SETTNGS RSTPEAKS

Led indications:
I Peak indication
Alignment range

Signal indicator
AID 1(8ch)

The leds indicate the inputs levels of the AD1 inputs 1 to 8
Note: You can reset a module Peak by doing Mouse + Click on the Module display section. In the
example above pressing A/D 1(8ch) will reset the peak displayed on the input 1.
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Meters web Settings:

Hot: -0.2dB

Alignment: -20 dB

Decay Int. Time: 25 msidB

Peak Hold:

“ < METERS

Settings
Hot: Sets the level above which the meter display will be red. If set to 0dB this will
mean clipping. Range -2dBFS to 0dBFS
Alignment: Sets metering level alignment range (yellow leds). Range -24dBFS to 0dB

Decay integration time: Sets the rate at which the level meter display decays after the level falls below
the most recent Peak.
Peak Hold: If ON it will keep the red Peak Hold Overload in display

IO & SYNC Web Access

The 10 and Synchronization menu is where the user can select the source of the Hapi reference clock.
It is essential that these settings are configured correctly in order to ensure a clean audio signal through
the Hapi unit. Refer to the OLED IO & Sync description for more details.

Headphone{Zch) DAS 1(&ch) ADE 1(8ch)
DXD DXD DXD

SPDIF(N/A)
Toslink

Status Sync (DXDVD'SD) AES(N/A}

Internal

TIMECODE

Timecode: Required Sync cable connectivity

Sync Source: RAVENNA
-100

Frequency:

5 | Level: <
5]

Mute on Stop: On

<10 & SYNC 5 i
& oy TimeCode
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PreAmp Web Access
= Allows the creation of up to 8 groups
= Naming of channels (can be saved in Hapi presets)
= VU meters

For other parameters, please refer to the PreAmps module description (above)
Note: The Boost PreAmps option available only for latest generation of ADA8S and ADA8P modules

Preamp web menu
e @ t secure | 169.254.68.109/me

8.0 24.0

RSTALLGRP RST PEAKS

ALL GRP Will include all faders into the selected group

RMN GRP Will include the remaining faders into the selected group
RST GRP Will reset the selected group

RST ALL GRP Will reset all groups, all grouping will be reset to default
SETUP Web Access

The Setup page once opens will bring you additional sub parameters pages and controls

Modules Presets

Info

Firmware Reboot to
Update Factory

Format
Sampling rate selection, Auto sampling rate and more. Refer to the OLED Format description
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Routing

Remote routing access page, where available modules will be displayed for selection. Refer to the

OLED Routing description

Modules

Headphone

MADI 1

TimeCode

“ < SETUP

Module menu will show the available Hapi Modules that your Hapi has in its configuration. Each module

type has its own set of parameters.

AD Module (optional

Mic Alignment: 0.0dB .

Serial Number: AP112513 (Run7)

Type: Premium

‘. < MODULES

MADI (optional)

Mode: Standard(56) Extended(64)

Physical Mode: Coaxial Optical

88.2/96k: 48k Frame 96k Frame

Output
Source:

“ <MODULES

AES (built-in

Qutput Source:

“ < MODULES

Emulation mode: 192110 HD IO HD MADI

Serial Number: PT429496

OQutput ~ RAVEN RAVENI RAVEN RAVENI RAVEN  RAVENI  RAVENI
Source: 310 118 19-26 734 3542 4350 5158

“ < MODULES ]

DA Module (optional

Max Level: +18 dBu +24 dBu

Gain: 0.0 dB .

Roll off Filter: Slow Sharp

Serial Number: DP81428 (Run 7) Type: Premium

Qutput Source: None

A < MODULES TRIM

SPDIF/ADAT (built-in

Physical Mode: SPDIF

Qutput Source:

“ < MODULES
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PRESET Web Access

Disk Presets can be stored and loaded on your local system where Hapi is connected to.

Save Presets
Load Presets
From Disk

To Disk

Reboot to Factory

- |Load Preset 4 From Disk

Save Preset : To Disk

Auto Save

Reboot to Factory Settings

“ < SETUP

Up to 5 presets can be saved and stored in the Hapi

Up to 5 presets can be loaded from the Hapi

Users can load some presets that were stored on your local Hard Drive
Users can save some presets to your local Hard Drive

Will reset all the Hapi parameters to the default factory settings

Note: Stored Hapi preset have a .bin file extension. In order to be able to rename the Hapi preset file at
save the Chrome browser users will need to adjust this Setting.

1. Go into Chrome Settings

2. Click on Show advanced settings

3. Under Downloads, check the box « Ask where to save each file before downloading »

Now when clicking on « to Disk » a window pops up that allows you to change the name of the preset
(.bin) file prior to saving it.

Settings

Passwords and forms

| Enable Autofill to fill out web forms in a single click. Manage Autofill settings

o Offer to save passwords I enter on the web, Manage saved passwords

Web content

Font size: Medium
Page zoom: 100%
Metwork

w || Customize fonts...

-

Google Chrome is using your computer's system proxy settings to connect to the network,

Change proxy settings...

Languages

Change how Chrome handles and displays languages

Languages and spell-checker settings...

of| Offer to translate pages that aren't in a language [ read

Downloads

Download location: | Ch\Users\mt-build\Downloads Change...

I of| Ask where to save each file before downloading I
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Note: When saving presets to Disk with the Chrome Brower it is possible that the save windows dialog
does not show up. It such case it is due to the browser Pop-Up blocker configuration. Make sure that
you allow pop-ups from your Hapi.

The following pop-ups were blocked on this page:

Leading...

@ Always allow pop-ups from horus_80059.local.

Continue blocking pop-ups

Manage pop-up blocking... Done

NETWORK Web Access
Hapi network configuration page

Device Name: HapiMkll_95003

IP Settings: Auto Manual

[

Netmask:

Apply & Reboot

“ < SETUP Network

The Hapi MKII RAVENNA provides two network operation modes

1- ST2022-7 for Seamless Protection Switching

2- Network Switch mode, allowing daisy chain for an extra network device

Those modes of operation are available from the RAVENNA Advanced Pages. Find more details here.
https://merging.atlassian.net/wiki/spaces/PUBLICDOC/pages/4819571/Merging+RAVENNA+Advanced
+Pages+User+Guide.

SYSTEM Web Access
Refer to the OLED System description.

ASIO Clock:

Home page:

Latency: < Low (64 smp)
Terminations: WCK: 715Q | | Video: 750
Brightness: < T >

Date & Time Set Current: 3M5/2021, 11:48:03 AM

A < SETUP

System
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INFO Web Access

In this sub menu you will find details about the Hapi internals; temperature, serial number and the
firmware version currently installed

Temperature 59 [°C]

Unit serial: H95003
ZMAN serial: 1214938

Firmware Version: 1.2.0b46052

“ < SETUP

EXIT Web Access
= Fi Reboot i
%  Shutdown Reboot Lr::j‘:‘t’:’ lfa;‘;;
Shutdown: Initiates a proper shutdown of the Hapi unit, including a save of the current

configuration. Do not attempt to shutdown the Hapi unit in other ways (such as
using the power switch on the back of the device).

Reboot: Power cycles the Hapi unit (shutdown>Boot up)

Firmware Update: Will open the Firmware update browser page. Refer to the Firmware update
procedure for more details

Reboot to Factory: If selected we will reboot the Hapi to the default factory configuration upon
confirmation. The Current configuration will be lost but all the saved presets will
be kept and can be reloaded.
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Identify Me — Device Location

The Identify me feature is available to locate a device over a network. If you have multiple network
Interfaces over a network you might at some point identify one of them.

The identified device will then blink so that you can locate it.

Procedure

1. Open the Hapi Mkll advanced pages.

This can be done form the Driver (MAD or VAD) or from MTDiscovery by Mouse+Right clicking on the
Hapi icon and open the Advanced Pages.

2. Once the Advanced pages are open go to the top right of the page

3. Check the Identify Me box

% RAVENNA Vendor Merging Technologies
Product
Serial aamvenanen
[ ¥ - @ Identify Me

General settings | PTP | ASIO Clock = Session sources  Session sinks | Ins/Outs | /O Router  Statistics =~ NMOS = System

Device Name

This is the unique zeroconf device name. Other devices see this device name
Audio Configuration

Sample rate 48 kHz =
Frame size (@1FS) 64 smpl -

Session Sinks Global

Safety Playout Delay (@1FS) D
SSM (requires IGMP v3)

4. This will identify the Hapi Mkll (or Anubis) and make the Hapi Mkll Power button blink

You have now identified your device over the network.
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HAPI MKIl embedded User Manual

The Hapi embedded User Manual can be opened by clicking on the question mark @ sign at the
bottom left of your browser. This will overlay the Hapi User Manual on your Web control access page.

Figure5 HAPI MKII Embedded User Manual

A, MEADPHONE METERS | VO& SYNC =~ PREAMP SETUP

Hapi MKII
User Manual

Disconnection Warning - Web Access

User will be warned it the remote web access to the Hapi become offline/disconnected.

Hapi Web Access Disconnected

Ho connection to Hapi device!

Waiting...
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HAPI & HORUS Setup Examples

RAVENNA Network For DSD256 Mix/Record With Backup Recorder

Live Room Mics
Stage Equipment
1x0C-HORUS with a total of
= 6xADSP Premium AD cards (48 Channels)

Live Room
Mix/Recording Room
. MassCore Pyramix Recording System
= PSI A215M reference monitors
«  Tango2 Control surface
= Secondary Audio Device over USB/PCle
= Talkback Microphone

Backup Recording/Editing Rig
. MassCore Pyramix Recording system
- Secondary ASIO Device (USB)

MassCore% RAVENNA

ASIO Device

Confidence
Monitoring

wMassCoreE RAVENNA ol st
e /
) 4

CONTROL ROOM

-

SlateMic: XLR

' Speaker Lines: XLR

Description

In this diagram, RAVENNA is used to connect a system that is capable of a 48 track DSD256
recording.

In the recording/mix room, Pyramix MassCore is used as the production tool from beginning to
end. By keeping the signal “in the box” over-use of DA and AD conversions are keptto a
minimum, thus preserving the sound to the highest degree.

During the whole recording, a second Pyramix MassCore system is kept online. Using the back-
ground recorders, it acts as a“snoop”and records the whole day ensuring that any mistakes in
the control room are covered with the backup. The second system can also double as a second
recording and editing station for busy studios.

ASIO Device

Oasis Control: CATS

RAVENNA Network For Mix/Record and Live transmission of multichannel performance

Stage Mics
Stage Equipment
1xI0C-HORUS with a total of
- 6xADSP Premium AD cards (48 Channels)
- 1x DA8 Standard DA card (swap out card STAGE

for one of the AD cards to provide a 40/8
configuration if needed)

Mix/Recording Room

+  MassCore Ovation Mix/ Playout Engine

- Pyramix Native Recorder on same computer
- PS5l A215M reference monitors

= Tango2 Control surface

- Secondary Audio Device over USB/PCle

- Talkback Microphone

Broadcast Room

Pyramix Native Music Pack

= MacAir Running Window7 64bit/Bootcamp
- ASIO RAVENNA Driver

- Secondary ASIO Device (USB)

ASIOSE |RAVENNA

ASIO Device

Broadcast Mix

y o———

AUDIO FOR THE NETWORKING AGE

CONTROL ROOM

Ma ssCorek RAVENNA

ASIO! RAVENNA

SlateMic: XLR

Speaker Lines: XLR

Oasis Control: CATS

Description

In this diagram, RAVENNA is used to connect a system that will allow the user to record the
multi-track event while at the same time creating a broadcast mix which will be embedded
with the video of the performance for “llve to alr” transmission.

In the Mix/Recording room, the MassCore RAVENNA stream is feeding the 48 inputs into the
Ovation Media Server and Sequencer application to mix it. From there, the stereo mix buss out-
put s then sent back Into the RAVENNA network in order to have It picked up In the broadcast
room by the Pyramix Native. This laptop setup then bridges the signal to an ASIO interface,
which then feeds the broadcast mix into the transmission stream.

Atthe same time as all of this Is happening, the Mix / Recording room computer Is also running
Pyramix Native in the background. This is connecting to the RAVENNA network using the ASIO
RAVENNA driver and Is able to record the same streams as are being fed to the Owvation without
having to areate a direct connection between the two applications.

The second GB switch that is in the Mix/Recording room is there for a future expansion where a
redundant recorder cold be put in place by simply plugging into the switch.

www.merging.com/hapi
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RAVENNA Network for Orchestral Recording with Multiple Microphone Positions

Roof Mics =— R
4 o R . .

Talkback Ret.  Stage Mics

STAGE
POSITION ABOVE THE STAGE

[* —

Y. o | | |

= 55 | RAVENNA

Y. o ||

B RAVENNA
CONTROL ROOM

Description Stage / Roof Equipment
This RAVENNA network example shows a recording 2xI0C-HORUS on stage with a total of:
where microphone placement varies greatly with «  11xADSP Premium AD cards (88 Channels)
respect to the position of the orchestra. «  1x DABP Premium DA Cards (8 channels) MassCore =
As Microphone cable lengths need to be keptto a 1xI0C-HORUS in the roof with: k RAVENNA
minimum length, being able to place the Mic-Pre «  2xADSP Premium AD cards (16 channels)
and AD conversion stage as close to the source is - A__ —
important. This setup is possible as all the Horus Control Room Equipment ) L8 e
units can be placed next to the microphone setups quip gg g;ﬁ?;g':
and then interconnected using the Gb network + MassCore Pyramix main rec / mix engine
switches. +  Mac Laptop backup recorder
Once the streams reach the control room, they are . PSIA215M reference monitors

recorded and mixed in the Pyramix MassCore rig by
using the Tango2 control surface as a remote inter- . Secondary audio device over USB/PCle
face to control everything for Mic-Pre level to all of . Talkback microphone

«  Tango2 control surface oy
the Eq and summing that is needed for the mix.

One should take special note to see that also

connected to the RAVENNA network is a Mac using

a CoreAudio based recording application in this

diagram. This means that the backup recorder can

not only record the multitrack, but also the mix bus
output of the Mix/Record MassCore Pyramix.

RAVENNA Network for Live Performance Broadcast

Mix/Recording Rig - Main and Backup

Comms Stage Mics ‘

ASIO
RAVENNA - \
» T

MassCore
% RAVENNA

STAGE

Secondary

Gb Switch :
T s Audio Device

Broadcast/Satellite Truck

k RAVENNA -
Gb Fibre Gb Switch
Description Stage Equipment 1x MADI I/P 2x MADI O/P
This signal diagram describes a workflow where a 3xIOC-HORUS with a total of
performance is to be recorded while at the same time . 15xAD8P Premium AD cards {120 Channels)
transmitted “live” «  3x DASP Premium DA Cards (24 channels)
The signal comes from the stage and goes through the
Horus units on stage to get into the RAVENNA network. Mix/Recording Room

The multi-track signal is then recorded in the Mix and
Recording suite onto the main and backup machine. Notice
that the backup recorder is connected using ASIO
{CoreAudio also available) meaning that aimost any DAW
can be used for the backup recording. The signal is also
mixed using the MassCore engine of the Main recording rig.
The output of the mixing/recording rig is then fed back

into the RAVENNA network and arrives at the broadcast/ N
satellite truck for combination with the picture before being ~ Broadcast/Satellite Truck

MassCore Pyramix main rec. and mix engine
Pyramix Native backup recorder

PS1 A215M reference monitors

Tango2 control surface

Secondary audio device over USB/PCle
Talkback microphone

streamed to broadcast. The additional MADI card onthe 10C-Horus with

Horus in the broadcast truck also means that the broadcast = |OM-MADM MADI Expansion Card for a total
truck is able to do its own multi-track recording at the same 0f 128 MADI channels

time.

‘AMERG'NG H www.merging.com/hapi
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RAVENNA Network For Edit / Mix Suite with Seperate Machine Room

Analogue Line Level Sony9pin  Vid Ref

SDI/HDMI %
2
m
-4
..... z
B
MACHINE ROOM
Gb Switch
Control / KVM over CATSE/CAT6 -
! & Description
The workflow example shows a typical dubbing and edit suite connected to a local
EDIT/MIX SUITE machine room which contains all of the heat sensitive and noise generating
equipment.

The Network Is being used to connect the RAVENNA enabled equipment together.
But, as RAVENNA can exist on the same network as other streams of information,
the same network is being used to create the connection for the Tango2 control
surface aswell as to extended the DVI and keyboard/mouse connections for the
Pyramix MassCore workstation. The video for the main screen is being fed from the
SDI eutput of a VCubeHD which is running on the same workstation as the Pyramix
MassCore.

RAVENNA Network For Edit / Mix Suite with Seperate Machine Room and VO Booth

Description

The presented signal diagram shows a post-production suite with an
attached voice over booth, isolated for ease of recording.

In this case, the Horus is able to act as the central source for all of the
audio in each room, due to the factthat the Pyramix MassCore
software is able to co-ordinate the talkback and monitoring streams to
the various rooms.

The Network s being used to connect the RAVENNA enabled equip-
ment together. But, as RAVENNA can exist on the same network as
other streams of information, the same network is being used to create
the connection for the Tango2 control surface as well as to extended
the DVl and keyboard/mouse connections for the Pyramix MassCore
workstation. The video for the main screen is being fed from the SDI
output of a VCubeHD which is running on the same workstation as the
Pyramix MassCore.

Voice Over Booth

Analogue Line Level

Sony9pin  Vid Ref

SDI/ HOMI =

MACHINE ROOM

Gb Switch

Control / KVM over CATSE/CAT6
EDIT/MIX SUITE

‘AMERG'NG H www.merging.com/hapi
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RAVENNA Network for Multiroom Museum Installation

Audio O/P <11 SN

Audio O/P <« HIEIES

Audio /P 5[ S8

Audio O/ «—— 4’_\

Al

Description |
In this Qvation installation, RAVENNA is allowing the mi:m
Ovation to control the shows being presented in 5

separate rooms of Museum.

The Ovation Control room Is able to monitor any one of
the rooms, or all 5 at the same time. As well, there is an
announcement microphone able to speak into any
amount of the rooms at the same time. From this
position, the show can be manually driven if neces-
sary, as well as emergency announcements sent when
needed.

Each Room uses audio outputs to create a separate
sonic environment. Also, control protecol cennections
are used to be able to connect to other parts of the

AV system that are located in each area. The use of the
switches Is to show that while room 1 and 2 are fairly
close and can be cabled directly, the run to rooms 3-5
are far enough away that a single line (potentially Fibre
could be used) in order to bridge the distance between
the control room and the 3 presentation rooms.

Lastly, the WIfi router in the middle of room 3-5 allows
for the webserver access to Ovation, allowing for show
control over the same network as the RAVENNA audio
streams.

.

ROOM 5 Audio O/F <« mi- i

LTC Out =——

A __.
ROOM 2
ROOM 4 Audio O/ «——— IS - 5
GPOOP «— [l ireaionn A
9 ROOM 1
" i
HUONES % RAVENNA

Mass Core
2 | RAVENNA

CONTROL ROOM

Secondary
Audio Device

RAVENNA Network for Multiple Mastering Suites with a Shared Machine Room

Description

This workflow example shows how best to connect 3 Pyra-
mix suites to a single, shared machine room.

The Machine room contains all of the source machines (1/4"
tape and other linear sources) that are controlled using the
sync outputs of the Horus unit. The RAVENNA streams pass
from the Horus into the Gb LAN switch and can then be ac-
cessed by any of the suites. As the control for the line inputs,
aswell as the sync information for the Horus is over the same
network connection as the RAVENNA stream, it means that
only one cable needs to go to the to the machine room.
Control over the Pyramix is made with a second network
connection to the Tango2 control surface.

Each DABP line output card is connected to its own studio,
providing discreet line outputs (5.1 Surround + Sterec) to
each mastering suite)

Itis also important to note that the RAVENNA connection
will also allow for signal to be easily and instantly shared
from control to control room as well, as any interconnections
is possible over the RAVENNA network.

Live Room Equipment

Machine Room IOC-HORUS with

Source

RS el Material

3xADSP Premium AD cards with Mic/Line (24Channels)
3xDASP Premium DA Line Qutput Card {24 Channels)

Studio Equipment:

»

% RAVENNA

Pyramix Native Turnkey
PSIA215M Near Field Monitors
Tango2 Control Interface using Oasis Protocol

] CATSE/CATe/Fibre CATSE/CAT6/Fibre

Studio 1

‘AMERGINGH
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Studio 1
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RAVENNA Network for Concert Event with standard FOH console

Speaker Feed  Stage Mics

STAGE

[oF frm L

B - B

&S
5

CATSE/CATG/Fibre 338 RAVENNA

Description

This signal diagram outlines a workflow where Horus and
RAVENNA AolP are used to create an 170 system for alarge
live concert event.

The signal comes from the stage and goes through the
Horus units on stage to get into the RAVENNA network.
The multi-track signal is then recorded in the recording suite
onto the main and backup machine. Notice that the backup
recorder is connected using ASIO (CoreAudio also available)
meaning that almost any DAW can be used for the backup
recording.

The signal is also being sent in parallel to the FOH posi-

tion and connected to the console using MADI Inputs. The
Buss outputs of the desk then feed back into the RAVENNA
stream and the signal is sent back to the Horus units on
stage to provide speaker feeds and monitor mixes. The

Mix output is also being sent simultaneously to the record
devices so as to capture the mix as well as the discreet
multi-track.

RAVENNA Network for Multiple Studios with a Shared Live Room

Shared Equipment

10C-HORUS with
= 1xADB8P Premium AD cards with Mic/Line (8 Channels)

= 3xDABP Premium DA Line Output Card (8 Channels/room)

Studio Equipment:

. Studio 1: PC Based DAW (Sequoia, SADIE etc)

- Studio 2: MassCore Pyramix

«  Studio 3: Mac-based DAW (Nuendo/Protools etc)
«  PSIA215M Near Feld Monitors

«  Tango2 Control interface using Oasis Protocol

«  Talkback Microphone

Description

In this signal diagram of a RAVENNA network we are show-
ing an incredibly useful feature of the Horus interface. Each
8 channels of Input or Output can be shared between a
Number of DAW's, OR dedicated to a specific one, allowing
for professional quality I/ to exist in each dubbing suite,
even though it is all being managed by a central piece of
equipment.

The diagram also shows that, by use of an ASIO or CoreAudio
RAVENNA driver, 3rd party DAW solutions on either Mac or
PC can cennect to the RAVENNA network. This means that
they can use and share the Horus I/0 as well as share signal
in between each workstation, provided of course all
workstations operate at the same common sampling rate

‘AMERGING
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Stage Equipment

3xIOC-HORUS with a total of

«  15xAD8P Premium AD cards (120 Channels)
«  3x DA8P Premium DA Cards (24 channels)

Recording Rig
MassCore Pyramix main recorder
«  Pyramix Native backup recorder
«  PSIA215M reference monitors
Tango2 control surface
Secondary audio device over USB/PCle
+  Talkback microphone

FOH position

10C-Horus with
1O0M-MADM MADI Expansion Card for a total
of 128 MADI channels

Shared VO Booth

MassCore

§§ RAVENNA

Y gl

Recording Rig With Main and Backup

ASIO Device
e |
MassCore
35S RAVENNA
Front of House
TS ————————=—=t
2x MADI I/P 2x MADI O/P

CoreAudio

% RAVENNA

L

Studio 1

CoreAudio
é\@ RAVENNA
J—

L]

Studio 2

Studio 3

www.merging.com/hapi
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RAVENNA Network for Multiple Studios with a Shared Live Room

Description

This workflow example shows how best to connect 3 Pyra-
mix suites to a single, shared live room.

The RAVENNA streams pass from the Horus into the Gb LAN
switch and can then be accessed by any of the suites. Asthe
control for the Mic-Pre Amps in the Horus is over the same
Network connection as the RAVENNA stream, it means that
only cne cable needs to go to the live room.

In each control reom, monitoring is achieved by using the
“secondary Audio Device Router”in Pyramix. This allows a
locally connected Audio interface to be used for multichan-
nel monitoring as well as talkback to the musicians in the live
room. It does this by bridging the Secondary Audio device
into the RAVENNA network so that all of this routing can hap-
pen transparently in the Pyramix Monitoring section.
Control over the Pyramix is made with a second network
connection to the TangoZ control surface.

Itis also impertant to note that the RAVENNA connection
will also allow for signal to be easily and instantly shared
from control to control room as well, as any interconnections
is possible over the RAVENNA network.

CATSE/CAT6/Fibre

Shared Live Room

8Ch. 40 Ch.
Cue Sends Mic/Line
from band

& RAVENNA

CATSE/CAT6/Fibre

Secondary
Audio Device

Studio 1

y o———

AUDIO FOR THE NETWORKING AGE

Live Room Equipment

10C-HORUS with
= 5SxADSP Premium AD cards with Mic/Line (40 Channels)

-« 1%DASP Premium DA Line Qutput Card (8 Channels)

Studio Equipment:

. MassCore Pyramix (could be Native as well)

. P5l A215M Near Field Monitors

+  Tango2 Control interface using Oasis Protocol
«  Talkback Microphone

Secondary
Audio Device

Studio 2

www.merging.com/hapi

Secondary
Audio Device

Studio 3
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HAPI
IOM-H-PT64 & Digidesign HDIO Setup

This document explains how to setup Pro Tools and the devices to use a Hapi with an IOM-H-PT64
module alongside a Digidesign HDIO with just one HD Native interface. HDIO can obviously be
replaced with any Digidesign Interface.

Hardware setup:

e Connect Port 1 of HD Native interface to Port 1 of IOM-H-PT64 on Hapi
Connect Port 2 of HD Native interface to Primary Port of Digidesign HDIO
Connect Hapi WCK Out to HDIO WCK In with coaxial cable

Connect Hapi to computer with Ethernet cable

See Block Diagram at the end of the Document

In Hapi:
e Inl/O & Sync, select Sync: PT2

In Setup -> Format, enable Auto-Follow

In Setup -> Format, choose WCK Output wanted (usage explained further)

In Setup -> Modules -> PT2, select Emulation mode: HDIO

In Setup -> Routing, route signals wanted to/from PT (NOTE: with only Port 1 connected, only
PT2 (1-32) are used @ 1FS)

In Pro Tools:
e Select Clock Source : HDIO#3 WCK

o Select 44k1/48kHz if WCK Output option is set to 44k1/48kHz
o Select Sample Rate if WCK Output option is set to Follow SR

With this configuration, you are now able to record/read Analog or Digital Signals with Pro Tools.

AVIERGING
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Manage Mic PREs from Pro Tools

To be able to manage the Hapi Mic PREs from Pro Tools, the latest Merging RAVENNA CoreAudio
Driver must be installed on the Mac OS.

1. The Hapi must then be linked to the Mac OS directly with an Ethernet cable.
The Hapi is accessible from Pro Tools once it is seen in the System Preferences -> Merging

RAVENNA settings window.

3. In Pro Tools Setup -> MIDI -> Input Devices window, select Hapi_90xxx_midi_pre_in.
In Setup -> Peripherals -> Mic Preamps, select Type as PRE, and select channel number

corresponding with the Slot your A/D module is seated in.

4. Enable View -> Mix Window Views -> Mic Preamps:
You are now able to manage the Hapi Mic Preamps options from Pro Tools.

Synchronization | Machine Control | MIDI Controllers

| Ethernet Controllers | Mic Preamps | Satellites | VENUE

Type
#1 |PRE
#2 none
#3 | none
#4 none
#5 | none
#6 | none
#7 none
#8 | none

none

Remote Lock-Out Mode

Receive From

Hr_80353__ 5

none

none

none

none

none

none

none

none

-

-

-

-

Send To

Hr_80353__ 5

none

none

none

none

none

none

none

none

-

-

-

-

Defaults

Retain Current Settings

All details are available in the Virtual Audio Device (formerly Core Audio) Guide:
http://www.merging.com/products/networked-audio/downloads

AVIERGING
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Pro Tools on PC Horus/Hapi

Analog

preamps can be controlled directly from within Avid Pro Tools running on a PC. In order to set

Pro Tools up for Horus/Hapi preamp control follow this procedure:

1.
2.
3.

8] rtp

Check the Horus/Hapi firmware version and update if necessary, to v19734 or above.
Connect Horus/Hapi to the system running Pro Tools through the Ethernet. port.
Download rptMIDI from here:
http://www.tobias-erichsen.de/wp-content/uploads/2020/01/rtpMIDISetup 1 1 14 247.zip
Install rptMIDI

Start rptMIDI

MIDE: using Apple Borjour

Directory

Horus_B0059_LTC out
Horus_80059_TC_ref
MIDI MTC (System Name)

169. 254.119.85:3004
10.0.0.87:500%

[l] n

Who may connect to me

ovons

rptMIDI control panel

In the My Sessions section (top left) click on the + button to add a new entry.
In the Session section (right) rename the entry in the Local name: field to HorusPre/HapiPre.
In the Directory section (bottom left) select the Horus_80xxx_midi_pre module entry to add it to
the Participants list.
At the top of the Session section check the Enabled box to enable the session.
Close the rptMIDI control panel.
. Open the MTDiscovery or ANEMAN application and check that the Horus is connected.
. Please see: Within Pro Tools on page 38 and follow step 10 and complete the subsequent
steps in Pro Tools followed by restarting Pro Tools

AVIERGING H www.merging.com/hapi
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HABPI

Block Diagram

Merging RAVENNA CoreAudio
Driver is needed to manage Mic Pres

RJ 45

A

Pro ._.oo_mm

!

Clock Source : “

HDIO #3 Wek “

1

1

1

1

1

IIIIIIIIIIIIIIIIIIIIIIII 1
Thunderbolt Port

I Y

——— e

Sync : PT2

AD1

PT 2 - Mode: HDIO

A

Format : Auto

AES 1

SPDIF

WCK Out

ADA1

AD2

AES

WCK In

IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII

e ——
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Use Horus-HAPI MIDI din
To be able to use Horus and Hapi MIDI din.

Prerequisite:

e Plug the Sync break out cable (CON-D15-VTC) at the back of your unit (SYNC connector)

On Windows :
Pyramix v12 > users:

Under the Pyramix Settings>Hardware>MIDI Sync page
In the Directory list, choose an Apple MIDI service suffixed by "...midi_din". This nomenclature
correspond to the Physical MIDI DIN port of a Horus/Hapi product.

1=

ror
ot e

i e

Kiss-Box MIDI 1 i - .
Kiss-Box MIDI 2 Horus_80157 MIDI DIN

E] Partidpants: |Name Latency

Horus_80157_midi_din ims

ASIO users :
1. Make sure your Horus / HAPI is detected in MT Discovery or ANEMAN
2. Download ans install RTPMidi http://www.tobias-erichsen.de/software/rtpmidi.html
3. Start RTP MIDI
4. In My Sessions section, click on the + sign to create a new session, and name it.
5. Once the Session has been created, select the device_name_midi_din in the available streams
and click on Connect.
@ rtpMIDL using Apple Bonjour Iﬁ
Setup |About|
My Sessions Session
Horus Emulator - Enabled 5012
Horus 80157 MIDIDIN -
= ppa SRR |5| Horus_80157 MIDI DIN

Directory

Pyramix_KAPPA_sync -
Pyramix_SATURM_sync
MADAC_100024_LTC_in
NADAC_100024_TC_ref
NADAC_100024_LTC_out
Pyramix_SAN-X&4_sync |

Disconnect

m |

| Address: Kappa:5012

Pyramix_CASTOR_sync - 10.0.0.77:5012

Pyramix_OCT&4_sync ok 169.254.169.104: 5012
192,168.20.1:5012

:

Who may connect to me - - é
[Anyone v] — «—

‘AMERG'NG H www.merging.com/hapi
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6. The midi_din stream will be passed in the Participants section, you can now use it in your
favorite application.

RTPMIDI do not properly always refresh, if you need to change your settings in RTPMIDI, you will have
to restart the computer for the changes to apply.

On MacOS:

Horus / Hapi MIDI DIN port can be used directly from within any DAW running on a Mac.
(RAVENNA Core Audio driver v2.0.28855 and above recommended).
In order to use a Horus / Hapi MIDI port in MacOS follow this procedure:

1. Check the Horus / Hapi firmware version and update if necessary to the latest version. (v28855
or above)

2. Connect Horus / Hapi to the system running the DAW through the Ethernet port. (v28855 or
above)

3. Make sure your Horus / HAPI is detected in MT Discovery or ANEMAN

4. All available MIDI DIN port available on the network will appear as a usual MIDI port. Il.e.

Reaper
[ ] REAPER Preferences uE
v General MIDI hardware settings
Paths MIDI inputs to make available (selectable as track inputs and/or learnable or action-bindable):
Keyboard/Multi-touch Device Mode
¥ Project Horus_ 80157 _midi_pre_in <disabled=>
Track/Send Defaults Horus_B0157_midi_din_in Enabled+Control
Media Item Defaults
v Audio
Device
MIDI Devices
Buffering
Playback MIDI outputs to make available (selectable as track outputs): AR RS DL
Seeking Device Mode
Recording Horus_80157_midi_pre_out <disabled>
Loop Recording Horus_80157_midi_din_out <disabled>
Rendering
¥ Appearance
Media
Peaks/Waveforms
Fades/Crossfades
VU Meters/Faders Reset all MIDI devices
Theme Editor On stop/play: Send all-notes-off Reset pitch Reset CC

=P [T Sy - R .

Find Enable the MIDI Input devices you wish to use by right-clicking on the Device oK

h GCancel
name and selecting Enable Input.
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HAPI MKII - Firmware Update Procedure

PREREQUISITES

ANEMAN v1.3.0 and above. Download from
https://www.merging.com/anubis/download

® An internet connection to download the latest Hapi MKII Firmware
https://www.merging.com/support/downloads#current-hapi-downloads

®  Connecting the ethernet interface of the Anubis to a Mac or PC system for the update
procedure

®  Google Chrome is the recommended browser

A Warning. Safari is known to cause update slowdown or update button might not appear.
Use Chrome

UPDATE PROCEDURE

1. Install ANEMAN or run MT Discovery (installed with some merging applications)

2. Download the latest HAPI MKIl Firmware from
https://www.merging.com/support/downloads#current-hapi-downloads

3. Connect your Hapi MKII network port to the system where you have downloaded the latest firmware
4. Launching ANEMAN will discover your Hapi MKII within seconds.

5. Once ANEMAN discovers Hapi MKII perform a Mouse + Right Click and select
Web Services> Maintenance Page

>

— L
T - HapiMKI_35003 |
HapiMKII Web Services HapiMkl_95003
95003 Clear errors Advanced Page

Maintenance Page

If using MT Discovery perform a Mouse + Right Click on HapiMKIIl and select “Open Maintenance page’

&) MTDiscovery - X
'O\ VIT Discover'y

WP/ rercing sErvices BonsouRe
| AMEFIEINE +
SWAMERGING

v 8 ZMAN
HapiMKi|_95003

MassCore Open Web App Page |
@ AsIO Open Advanced Page

'@ CoreAudio Open Maintenance Page

| & Others

Note: It is also feasible to access the Firmware Update from the Web Access > SetUp page

Format Routing Modules Presets

System Network Info

= Firmware Reboot to
= Shutdown Reboot Update e

‘A
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6. This will open a browser page from which you will be able to select the .hapimkii firmware file

[ HAPLMl n Maintenance Mode X |+

C {d A Notsecure | 169.254.250.111:3080

Please select the firmware image file to
update your HapiMkII_95003 device with:

! l - No File Selected -

Select File

7. Use the “Select File” button to select your firmware

8. This will open the explorer form where you can load the Hapi MKIl Firmware

€ Open

« v 4 |+ ThisPC » Downloads > Delete >

x
v © | searchDelete

Organise ~ New folder = m @

A Mame Date modified Trpe
# Quickaccess
= Desi [7] Firmware_1.2.0. 45862 hapimkii 11/30/2020 748 AM  HAPIMKII File: 54,630 KB
esktop

4 Downloads

[ Documents

=] Pictures

D Music

File name: | Firmware_1.2.0 45862, hapimkii

v‘ HAPIMKIl File (* hapimkii)

Once the firmware is selected press the Update button

[©) HAPLMI in Maintenance Mode X | +

C 1 A Notsecure | 169.254.250.111:8080

&—

Please select the firmware image file to
update your HapiMkll_95003 device with:

! | Firmware_1.2.0_45862.hapimkii

‘AMERGING
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10. Wait for the upload and update to complete.

AWarning. Never abort the Firmware when it is updating, this could damage the HAPI configuration.

[E) HAPLMKI inMaintenance Mode X+
C O A Notsecurs | 169.254.250.111:8080

L]

Notice that your Hapi MKIl OLED will also display the progression of the update.

Update in progress...

A Warning: We do not recommend that you refresh the browser page or restart the Hapi while a
firmware update is in progress.

11. Once the Firmware update is completed please reboot your Hapi MKII. You can do this from either
the browser or the Hapi MKII OLED, by selecting “Reboot Device”

|| B ot
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You should now be on the latest Firmware. You can verify the Firmware version of your Hapi MK by
opening the Info page under Setup>Settings>Info

192kHz B M Info

Temperature: 56 [°C]

Unit serial: H95041
ZMAN serial: 121450

Version: 1.2.1b46910

In case you cannot access the Hapi MKIl Maintenance mode.

Make sure that Hapi MKII is well connected to your system, it is mandatory that the Ethernet port or
Switch is a Gigabit one.

Under the Setup>Settings>Info page take note of the written IP Address (ideally be set to Auto IP on
both your Hapi MKII and Network Interface card).

Type the Hapi MKII address in your Chrome browser followed by :8080 Example: 169.254.250.11:8080
You could also just open the Hapi web access page and add the :8080 at the end of the IP address,

follow by pressing enter.
You should now have access to the Hapi Maintenance page and be able to update your Hapi firmware

Start Up in Maintenance Mode (Rescue)

In case of problems updating the firmware or not being able to see the Hapi for update. You can start
up the Hapi Mkll in Maintenance Mode by pressing the power button and simultaneously pressing the
Rotary encoder for a few seconds.

The Hapi MkII will then start in Maintenance Mode and will be ready for a firmware update.
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HAPI - Troubleshooting

Hapi on screen Error Report

Your Hapi can display on the OLED screen some detected errors. In case of an error report the Hapi
will display the message on its screen. Refer to the error list below as a reference. Once the issue is
sorted Press the “clear” button to remove reported error. If the message reappears it indicates that the
error is still present.

Hapi Error report example:

48k EM E Errors
Etharnet input: Wrong sequence
mnnnbser

4BV power failure: all AD 48V
forced of f wntil nesct reboot.

Potential reported errors:

"Primary Power Supply Failure";

"Secondary Power Supply Failure";

One of your Power supply is down, it is recommended that you eventually shutdown the Hapi and verify
your power cord connections

"Hapi Application failure, please reboot"
The Hapi internal application has failed. Will require a reboot, make sure that you are using the latest
Hapi firmware available. If the problem persists contact support@merging.com

"Ethernet input: GP fifo overrun";

"Ethernet input: GP descriptors fifo overrun”;

The Ethernet communication is overloaded. The bandwidth is too small. Verify your set up, take note
that a RAVENNA Network configuration must be running on a dedicated and certified Merging Switch. If
problem persists contact our support team.

"Ethernet input: Audio packet still pending”;

"Ethernet input: Audio pipeline too small";

"Ethernet input: Wrong sequence number";

"Ethernet input: CRC error";

"Ethernet input: Queue mux error";

"Ethernet input: Audio buffer too small";

"Ethernet input: SSRC mismatch"

Error on the incoming RAVENNA streams. There might be click on the physical output of the Hapi.
Such a click could have occurred on one of the RAVENNA bank of 8 channels. Verify your set up,
mainly on the network side and afterwards clear the error. If the problem persists contact our support
team.

"Ethernet input: Unknown error";
"FPGA memory: Timeout";
"FPGA memory: Unknown error";
Contact Merging Support
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“48V power failure: all A/D 48V forced off until next reboot”
The attached error message is displayed when:

1. 48V is malfunctioning

2. If there is a short circuit on 48V

If a MAJOR (by MAJOR, we mean that the threshold of short-circuit detection requires at least 10
Preamp inputs to be shorted simultaneously) 48V Phantom Power Supply short circuit is detected, 48V
is forced off on all A/D channels and the following error message is displayed.

Note: 48V will be forced off until reboot.

Note: the user 48V settings are not affected i.e. the Ul still shows the 48V as configured by the user.
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How to provide Merging Support with a Hapi MKII Debug Report file

1. Connect your Hapi MKII to your system via Ethernet
2. Open MT Discovery or ANEMAN and Mouse+Right Click on the Hapi MKII entry to select
Advanced Page

&

[ o

HapiMkIT
95003 Web Services 4 HapiMk|_85003

HapiMkll_95003

Clear errors Advanced Page

Maintenance Page

3. This will open RAVENNA Advanced page in your web browser (e.g. Google Chrome)

= O X
) HapiMkII_95003 X & HapiMkll 95003 x  +
c 0 A Mot secure | 169.254.250.111fadvanced/index.html T e H
ig RAVENNA Vendor Merging Technologies
Product HAPI_MkII A
Seria 35003 M\ vERcING

& | Hapimki_gso03.iocal |~ @

General settings =~ PTP = Session sources ~ Session sinks  Ins/Outs = I/O Router  Statistics =~ NMOS 4

Build Number
1.2.0045862

Configuration file
Download || Upload
Commands

Reboot
Reboot to Factory

Save

Debug

] 5

Get Device Status || Get Device Engine Status

4. Select the System Tab
5. Click Get Report button and save HapiMkii_95xxx_report.bin file.
8. Send to Merging the .bin file report.

Firewall and Antivirus

Windows Firewall:

The Windows Firewall can block communication between MassCore and Hapi.

By default, the built-in Windows Firewall should be automatically configured by the installer, but in some
special cases, the user might have to configure it manually.

Antivirus: Merging also recommends users to configure their Antivirus, some Antivirus as Avast or
Sophos have been known to block the Hapi discovery and RAVENNA 1/O Connections

Please see the details on
https://merging.atlassian.net/wiki/spaces/PUBLICDOC/pages/4820536/Antivirus+and+Merging+Technol
ogies+Softwares

AVIERGING

:] www.merging.com/hapi
AUDIO FOR THE NETWORKING AGE


https://merging.atlassian.net/wiki/spaces/PUBLICDOC/pages/4820536/Antivirus+and+Merging+Technologies+Softwares
https://merging.atlassian.net/wiki/spaces/PUBLICDOC/pages/4820536/Antivirus+and+Merging+Technologies+Softwares

HABPI

FOR MORE INFORMATION

MERGING+HAPI Website
https://www.merging.com/products/interfaces/hapi

MERGING+HAPI Downloads
https://www.merging.com/support/downloads#current-hapi-downloads

MERGING Knowledge Database, FAQs and Tutorials
https://merging.atlassian.net/wiki/spaces/PUBLICDOC/overview

MERGING SUPPORT
support@merging.com

MERGING YouTube CHANNEL
https://www.youtube.com/channel/UCR5q _dIb9dYnXTrVDWMshgw
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